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Copyrights and Trademark Notices
Copyright © 2025 Telestream, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
Pipeline, Sentry, Surveyor, Vantage Cloud, CaptureVU, FlexVU, PRISM, Sentry, Stay 
Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its Affiliates. All 
other trademarks are the property of their respective owners. 

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

intoPIX and Fraunhofer. Notice under 35 U.S.C. §287(a): This product or service 
includes JPEG XS compliant features that are covered by patents in the United States 
and in other jurisdictions owned by intoPIX SA (“intoPIX”) and/or Fraunhofer-
Gesellschaft zur Foerderung der angewandten Forschung E.V. (“Fraunhofer”) and listed 
at HYPERLINK http://www.jpegxspool.com. Additional patents may be pending in 
United States and elsewhere.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 



Live Capture Administration Guide 
Copyrights and Trademark Notices

3

Live Capture Administration Guide

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2016|Server 2019|Server 2022, Windows 10, 
Windows 11, Media Player, Media Encoder, .Net, Internet Explorer, SQL Server 
2012|2016|2019|2022, and Windows Media Technologies are trademarks of Microsoft 
Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.
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Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
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ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
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neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing: 
Telestream, LLC 
848 Gold Flat Road 
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: EN 55032, IEC/EN 61000-3-2, IEC/EN 61000-3-3, FCC Part 15 
Subpart B, ICES-003, VCCI 32-1, AS/NZS CISPR 32

Electromagnetic Immunity: EN 55035

Safety: IEC 62368-1, EN 62368-1, CSA C22.2 No. 62368-1-14, UL 62368-1

California Best Management Practices Regulations for Perchlorate Materials: 
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Contact Telestream Customer Service for additional Regulatory Compliance certificates
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Obtaining Support | Information | Assistance
Contact Telestream for support, information or assistance, as indicated below.

Resource Contact Information

Lightspeed Live Support Website: telestream.net/telestream-support/lightspeed-
live/support.htm 

Support Portal: https://support.telestream.net

Support Email. support@telestream.net

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Licensing Website: telestream.net/telestream-support/lightspeed-
live/support.htm

License Email: license@telestream.net

Lightspeed Live 
Information | Assistance | 
FAQ | Forums | Upgrades

Website: telestream.net/telestream-support/lightspeed-
live/support.htm 

Support Email: support@telestream.net

Telestream, generally Website: telestream.net

Sales and Marketing Email: info@telestream.net

Telestream Reseller 
Support

If you purchased your product from a reseller, please 
contact your reseller for support.

International Reseller 
Support

Website: telestream.net

See the website for your regional authorized Telestream 
reseller.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document or other Telestream documents—or if 
you've discovered an error or omission, please email us.

https://www.telestream.net/telestream-support/lightspeed-live/support.htm
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
mailto:support@telestream.net
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
mailto:license@telestream.net
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
mailto:support@telestream.net
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
https://support.telestream.net
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Return Material Authorization (RMA) Procedure
If your Lightspeed Live Server requires service of any kind, regardless of whether you 
purchased the Lightspeed Live Server from Telestream or an authorized reseller, 
contact Telestream directly for a Return Material Authorization (RMA).

Caution: Except for the modular power supplies and disk drives, the Lightspeed 
Live Server is a sealed device, with no user serviceable parts inside. You should 
never open the top cover or attempt to upgrade or alter the server. Doing so 
exposes you to electrical hazard, may damage the unit, and may invalidate your 
warranty.

Please contact Telestream via email at support@telestream.net for all internal service of 
the server.

Provide your organization name, and contact information, the serial number of the 
inoperative unit, and request a Return Material Authorization.

Before returning your Lightspeed Live Server, back up the entire contents of all server 
drives to protect against data loss. See Backing up a Lightspeed Live Server for details.

mailto://support@telestream.net
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Live Capture Administration Guide

Introduction

Telestream’s Live Capture is an enterprise-class system hosted on a Lightspeed Live 
Server or a VM | cloud platform to perform real-time, enterprise-class live and tape-
based media capture—encoding and serializing it into a file—for media and 
entertainment companies, corporations, government agencies, and educational 
facilities. 

This guide—Live Capture Administration Guide—is intended primarily for those who 
are responsible for setting up and managing Live Capture systems. It includes topics on 
licensing, server installation and updates, plus Live Capture management topics. 

The Companion Live Capture User Guide is primarily intended for operators—
personnel who are using Live Capture to perform video capture tasks.

To install a Lightspeed Live Server in your facility, refer to Installing & Managing Your 
Lightspeed Live Server. You can also use this chapter to manage and monitor your 
servers.

Next, turn to Configuring Vantage and Updating Live Capture to configure your Live 
Capture system and start capturing video. In that chapter, you’ll find an Up and Running 
Checklist which describes the initial tasks you should perform to get started. 

Note: This guide uses different terms when referring to Live Capture platforms: The 
term Lightspeed Live Server refers to Telestream’s high-performance Windows server, 
whose components are selected specifically to host Live Capture. The term Live 
Capture server refers more broadly on any supported platform hosting Live Capture: A 
Lightspeed Live Server, or a VM | cloud platform.

Topics
■ Live Capture Overview

■ Live Capture Web Apps and Windows Services

■ Live Application Program Interfaces

■ Live Capture Licensing

■ SDI Source Video Formats

■ SDI Audio Formats

■ Lightspeed Live Server Specifications

■ Live Capture Software-Only Server Requirements
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Live Capture Overview
Designed for demanding, enterprise-class broadcast and professional video capture 
applications, Telestream’s Live Capture offers premium features and exceptional 
performance. Live Capture excels at performing demanding video ingest from similar 
or mixed format sources, while simultaneously creating multiple, high resolution and 
proxy files from any live source.

Live Capture is flexible and scalable. When hosted on a Lightspeed Live Server, Live 
Capture supports up to eight 3G HD SDI inputs with active loop through for 
monitoring, or up to two UHD/4K inputs with active loop through for monitoring. 
When equipped with 12G SDI, it supports two HD SDI or UHD/4K inputs.

Live Capture also supports IP sources—RTMP, MPEG2 Transport Stream, NDI, and SRT—
and ST 2110 (via text / HTML SDP files or NMOS) when the Lightspeed Live Server or 
other platform is so equipped, with the ST2110 + NMOS option.

Lightspeed Live Capture encodes live streams in select formats and codecs. Live 
Capture processes video in 16-bit space to preserve source quality and encodes it in 
multiple video formats, while simultaneously creating high-resolution mezzanine 
H.264/AVC proxy files. Files are written directly to the Lightspeed Live Server’s local 
RAID storage or to external shared NAS | SAN storage, or AWS S3 Cloud storage.

Live Capture is configured, operated, and controlled via the Live Capture and Tape 
Capture Web apps, and several Live Application Program Interfaces are provided for 
integration and control by other systems. Optional editing, scheduling and live 
playback web apps are also offered, plus optional SDI routing control via RouteMaster.

8 x SD/HD/3G SDI

2 x UHD/4K 3G SDI

4 x UHD/4K 12G SDI

On-Premises VM Lightspeed Live Server

Cloud VM Lightspeed Live Server

DAMs, SANs,

NAS & Archives

Editing Workflows:

Adobe | Apple | AVID
(Interplay Compatible)

TS | RTMP 

SRT | NDI | ST2110
Broadcast | Playout Servers

Live Feeds

VTR | Server

Cameras

LightSpeed Live Server

FTP | S3 | AsperaManual &

Scheduled

Recording

Log &

Capture

Live Play

Source

Manager

Live

Schedule Web 

Service 

API

IP Sources

SDI Sources - Lightspeed Live Server Only

On-Premises VM Lightspeed Live See Sed L

Cloud VM Lightspeed Live SeSe

LightSpeed Live Server
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More Choices, More Flexibility
Live Capture offers a variety of methods to ingest video: 24/7/365 scheduled recording 
of live feeds, RS-422-controlled VTR tape capture, manual recording including gang 
control, DAI (SCTE-104) triggering (headless; no operator intervention), recurring 
segment creation, and automated control through a simple Web Service REST API. 

Live Capture encodes captured video into MXF OP1a, QuickTime or Telestream TIFO 
format. To maintain closed captions and other ancillary data, Live Capture preserves it 
in MKV, MP4, Op1A, QuickTime and TIFO containers.

Media Platform Friendly
Live Capture creates growing files that directly support a wide variety of 3rd party 
Media Asset Management (MAM) and Non Linear Edit (NLE) solutions including Avid 
Media Central Production Management, Avid Media Composer, Adobe Premiere, 
DaVinci Resolve, and Apple Final Cut Pro.

Fast, Parallel Open Media Processing
As a standalone system, Lightspeed Live Capture acquires SDI video from independent 
input channels or through IP connections. You can join multiple Live Capture servers 
together to create a Live Capture array under a common control interface. Live Capture 
is integrated directly with Vantage, enabling unlimited workflow possibilities via 
Vantage’s Telestream Media Framework.

Live Capture workflows support Open workflows to perform transcoding, packaging, 
and deployment in near real time, as the media is being captured. These media 
processing workflows complete within seconds following the end of media capture. 
You can also deliver Live Capture proxy (secondary) output in HLS | DASH format to 
Amazon S3 storage during file generation by the Capture action with a Push action 
immediately following, executing in Open mode.

File-Based Transcoding on Live Capture Servers
File-based transcoding directly on Live Capture servers is an optional, separately 
licensed feature. Transcoding options enable Vantage file-based transcoding when not 
in use capturing media, enabling you to utilize your Live Capture server for both live 
video capture and traditional file-based transcoding.

Note: Live Capture is integrated with Vantage Telestream Media Framework for 
ingesting live, live-linear and tape-based media for serializing media into files for 
processing in production, post-production and broadcast workflows. In the context of 
this guide, it is simply referred to as Vantage.  
If you are performing concurrent ingest and encoding—using Open Workflows 
(Transcode while Ingest workflows)—you must perform transcoding workflows on a 
separate Vantage server, not on the Live Capture Server where ingest is executing.

When you’re ready to get started, proceed to the Up and Running Checklist.
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Live Capture Web Apps and Windows Services
Live Capture is comprised of programs implemented as Windows services, and web 
applications to provide users a graphic interface to utilize Live Capture’s features and 
functionality.

Topics
■ Live Capture Web Apps

■ Live Capture Windows Services

Live Capture Web Apps
Live Capture includes several client programs implemented as web apps:

• Live Capture—The Live Capture Web app (Capturing Live Video) is implemented by 
the Telestream Live Service and enables you to capture live video streams from SDI 
or from IP-based sources, and save them as files.

• Tape Capture—For tape-based media, the Tape Capture web application (Capturing 
Tape Media), which is implemented by the Telestream Live Service, enables you to 
capture tape-based media, typically in conjunction with a VTR.

• Live Schedule Pro—Live Schedule Pro is an optional, separately licensed feature for 
automating 24x7 capture events using a calendar interface, and includes optional 
RouteMaster for SDI router control.

Live Schedule Pro is implemented in the Telestream Schedule Service, and enables 
you to create recording events you want captured for each source, and automati-
cally starts and stops capturing video on an event-by-event basis, with optional SDI 
router control. Live Schedule Pro has a separate installer and is installed inde-
pendently of other web apps.

• Live Play—Live Play is an optional, separately licensed product. The Live Play web 
app, implemented in the Telestream Playlist Service, is an enterprise-class software 
solution that provides flexible and scalable SDI video playback on Telestream’s 
Lightspeed Live Server. 

• Source Manager—Source Manager (Managing Video Sources), implemented in the 
Telestream Live Source Service, enables you to create, configure, and manage all of 
your video source inputs from a central web app.

• Group Portal—The Group Portal web app (User Administration) and also utilizes the 
Telestream Live Source Service. It enables you to create users with specific privileges 
for managing or monitoring servers in an array according to typical roles.

Live Capture Windows Services
Live Capture is supported by these Telestream services:

• Telestream Live Source Service

• Telestream Cloud Service
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• Telestream Schedule Service (when Live Schedule Pro is installed)

• Telestream RouteMaster Service (when Live Schedule Pro is installed)

The Vantage domain installed on a Live Capture Server includes these programs:

• Vantage Management Console

• Vantage Workflow Designer

A Vantage domain for Live Capture also includes these Windows services:

• Vantage Analysis Service (requires optional licensing)

• Vantage Avid Service (requires optional licensing)

• Vantage Communicate Service

• Vantage Live Service

• Vantage Metadata Service (requires optional licensing)

• Vantage Metric Service

• Vantage Monitor Service

• Vantage Signiant Service (requires optional licensing)

• Vantage SDK Service

• Vantage Transcode Service (requires optional licensing)

• Vantage Transport Service

You can’t install or execute other Vantage or Telestream services on a Live Capture 
Server without a specific license.
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Live Application Program Interfaces
These APIs enable you to monitor and control your Live Capture system within a 
broader, web services-based system or create your own custom monitoring system. 
You can also submit and monitor capture jobs in Vantage using the Vantage API.

Topics
■ Vantage API

■ Live Source API

■ Live Capture API

You can also create a web services-based system to control capture operations beyond 
the functionality or capability of Telestream’s Live Capture web applications, to meet 
your organization’s requirements.

Vantage API
The Vantage API is required for any workflow integration, in addition to other APIs you 
may require.

Vantage provides an SDK to expose the REST API, which is designed to enable third-
party programs to submit jobs to Vantage workflows, monitor and manage jobs, and 
access job’s metadata and their files, and perform other tasks in Vantage. The Vantage 
API is language independent and supports the use of REST, SOAP or WCF protocols.

The Vantage API Reference is published on the Telestream web site for registered 
Vantage users.

Live Source API
You can use the Live Source REST API for creating and configuring SDI and IP sources for 
use in Live Capture via an external program / system. The Live Capture API is 
implemented in the Telestream Live Source Service.

The Live Source API is described at  
http://<Server>|localhost:15000/help/index.html 
where <Server> is the host name of the Live Capture server or keyword localhost when 
accessed locally.

Live Capture API
The Live Capture REST API enables you to automate and control Live Capture servers 
via an external program/system. The Live Capture API is implemented in the Vantage 
Live Service.

The Live Capture API is described at  
http://<Server>:17000 | 19000 | <Capture Action Port>/swagger/
help/index.html 
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where <Server> is the host name of the Live Capture server or keyword localhost 
when accessed locally.

Note: To display the Live Capture API help pages, create a Live Capture workflow in 
Workflow Designer. Configure it to use a Web Service trigger and configure it with 
server and port you’re using. Activate the workflow, and then display the help pages.

The default port for Web Service triggers is 17000; the default port for Recurring 
Segment triggers is 19000. The port number may change, based on the port number 
specified in the target workflow’s Capture action. If you are using multiple Capture 
workflows, you should configure each with a different port.
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Live Capture Licensing
A Live Capture license is required for all Live Capture systems.

Topics
■ Single Server Licensing

■ Software-Only Licensing

■ Array Licensing

■ Optional Licenses

Single Server Licensing
This topic describes required and optional licenses for a single-server Live Capture 
system for all models of Lightspeed Live Servers, as well as Live Capture installed on a 
VM | cloud platform.

To obtain licenses or obtain licensing information or assistance, please contact your 
Telestream Representative. Also see Obtaining Support | Information | Assistance.

Note: License files may contain one or more license policies, and there may more 
than one license file in a Vantage domain. The number of license files is immaterial; 
only the license policies within the file(s) are relevant. License installation is described 
in the Domain Management Guide.

You add Live Capture license files to the Vantage domain, where the license policies are 
extracted from the file(s) and stored in the Vantage database for utilization. 

You use the Vantage Management Console to add, view, and manage licenses. See the 
Vantage Domain Management Guide directly in the console, for details.

Software-Only Licensing
Software-Only Live Capture requires a Live Capture Software license. It enables these 
features:

• Open workflow support in Vantage

• Perform one capture (execute one workflow) at a time per license instance.

Use of a Live Capture Software license imposes these limitations:

• GPU-based encoding is supported on systems with an Nvidia GPU.

• Comprimato JPEG2000 encoding requires an additional license. (Comprimato 
JPEG2000 encoding typically requires higher capacity than other encoding.)

• You can have multiple, active Capture workflows, but you can only perform a single 
capture operation at a time. Simultaneous captures are not permitted.

• Pass-through GPUs are supported, but not required. 
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Array Licensing

Note: License files may contain one or more license policies, and there may more 
than one license file in a Vantage domain. The number of license files is immaterial; 
only the license policies within the file(s) are relevant. License installation is described 
in the Domain Management Guide.

When you add a license file to your Vantage domain, the license policies are extracted 
from the file(s) and stored in the Vantage database for utilization. You use the Vantage 
Management Console to add, view, and manage licenses.

• A Live Capture license includes a Vantage array license—one license per server. 

• All Vantage servers joined together with Live Capture servers also require an array 
license for each Vantage server. If you have a stand-alone Vantage domain and are 
joining it to a separate Capture server—creating an array, you require an array 
license for it.

These examples illustrate the requirements for licensing Vantage domains including 
Live Capture servers, except for those systems purchased as a single server.

Single Server Vantage Domain Adding Live Capture
A single server Vantage domain is being joined to a Live Capture server—this requires 
two array licenses. For this system you order a single-server array license for the 
Vantage server. You receive a license file containing array licenses for both servers; one 
for the Vantage server and one for your Live Capture servers.

New Vantage Arrays Including Live Capture
Example 1: A new system consisting of two Live Capture servers and two Vantage 
servers in an array requires four array licenses. For this system you order a two-server 
array license for the Vantage servers. You receive a license file containing array licenses 
for four servers; two for the Vantage servers and two for your Live Capture servers.

Example 2: A new system consisting of five Live Capture servers and three Vantage 
servers in a Vantage array requires eight array licenses. For this system you order a 
three-array license for the Vantage servers. You receive a license file containing array 
licenses for all eight servers; three for the Vantage servers and five for your Live Capture 
servers.

Existing Vantage Arrays When Adding Live Capture
Example: You are adding Live Capture servers to an existing Vantage domain that 
already has array licensing. Thus, no additional array licensing is required. However, you 
should update the existing Vantage license file to include the additional Live Capture 
server.

In a mixed Vantage/Capture array, you can’t host Transcoding services on the Capture 
servers, or failures of Capture jobs and other, non-capture Vantage jobs will occur. 
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Remove the Vantage Transcode service from Live Capture servers via the Vantage 
Management Console.

Optional Licenses
• Basic Single File Analysis (LSL-ANLZ-SW)—includes single-file analysis for curtains, 

letter-boxing, Telecine, black detection, slate/spot detection, macro-blocking, loud-
ness measurement with dialog detection and gating controls for compliance with 
CALM Act, ATSC A/85, BS-1770-2 and EBU R128, and more. Includes PSNR measure-
ment for two-file QC analysis. Does not include first year of Software Annual Main-
tenance and Support which must be ordered at time of purchase. Refer to 
Maintenance section for more information. Intended for use on Live Capture sys-
tems while no ingests are being performed.

• Extended Single File Analysis (LSL-ANLYZ-PRO-SW)—Includes all capabilities of 
Basic Single File Analysis, with additional capabilities for Dolby Atmos audio loud-
ness, Dolby Vision metadata extraction, Dolby E audio detection and analysis, com-
pliance checking, PDF reporting, and integration with MediaInfo for extended 
media properties. Intended for use on Live Capture system while no ingests are 
being performed.

• JPEG2000 codec option for Live Capture (LS-LIVE-CAP-J2K)—enables JPEG2000 SD/
HD recording up to 1080p60.

• MPEG2-TS with Manzanita Option for Live Capture (LS-LIVE-TS-OPTION)—providing 
support for MPEG2 Transport Stream container with Manzanita multiplexing. Sup-
ports Live Capture's MPEG-2 and x264 video codecs.

• Avid Integration (LS-LIVE-AVID-OPT)—enables the creation of Avid-compatible 
MXF OPAtom and AAF media files for use directly in a standalone Media Composer 
edit system, or written in real time to Avid shared storage and checked-in into Avid 
Interplay. This option is available only for standalone or multiple channel Live Cap-
ture systems. Live Capture servers that are integrated into Vantage domains use the 
Vantage Avid Interplay Option (V-AVID).

• Vantage Metadata Conversion (V-METADATA-SW)—enables ability to transform 
XML files, create or populate metadata labels, and perform Web Services notifica-
tion in Web Services notification, Populate, Transform, Extract, Gather and Archive 
actions.

• Array Pro upgrade for Capture (LSL-ARRAY-PRO-UPG)—matches the Array Pro 
license for connection to Vantage since you can’t mix regular Array with Array Pro 
on Vantage domains. This allows Open Workflows that include Capture but start 
with Watch and Receive origin actions. This is required for workflows that update 
other systems using a typical Receive workflow—Receive > Populate > Notify. For 
example, Avid Interplay metadata and Edit While Capture in Media Creation 2022.2 
and later.

• Vantage Transcode (V-XCODE-SW)—includes Vantage Workflow Designer, SD & HD 
New Media, Edit, H.264 and MPEG-2 Transcoding Format support, FTP/Network 
folder workflow support, Enhanced Video Processing.
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• Vantage Transcode Pro (V-XCPRO-SW)—includes Vantage Workflow Designer, SD & 
HD New Media, Edit, H.264 and MPEG-2, Broadcast Server and MXF transcoding for-
mat support, and FTP/Network folder workflow support. Allows creation of AAF 
files for Media Composer (without Interplay).
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SDI Source Video Formats
Live Capture supports the following SDI source formats, at indicated frame rates:
 

* Image division and 3G level are detected automatically based on VPID data. If VPID 
data is not present or is incorrect, image division must be manually set. In the Source 
Manager web app, display the Configure Source panel (when Video Mode is specified 
as QuadLink Video) and set Quad Link Image Division to 2SI. See Configuring SDI Sources 
for details.

Note: Sources in YCbCr 444 or RGB 444 color space are not supported. Only YUV 422 
color space is supported.

Source Rate 23.98 24 25 29.97 30 50 59.94 60

SD NTSC 525i ■

SD PAL 625I ■

HD 720P ■ ■ ■

HD 1080p ■ ■ ■ ■ ■ ■ ■ ■

HD 1080PsF ■ ■ ■ ■ ■

HD 1080i ■ ■ ■

UHD 3840x2160p ■ * ■ * ■ * ■ * ■ * ■ * ■ * ■ *

UHD 3840x2160PsF ■ ■ ■ ■ * ■ * ■ * ■ * ■ *

4K 4096x2160PsF ■ ■ ■
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SDI Audio Formats
• 16-channel 24-bit Little Endian SDI embedded, 48 kHz synchronous

Input Reference
• SD/HD—Reference is derived from an internal free-run clock on each SDI port or 

from external reference. 

• QuadLink UHD—Reference is derived from SDI port or from external reference.

Output Reference
• SD/HD—Reference is derived from internal free run clock or external Bi-Level or Tri-

Level (TLS) reference source. See Using External Reference (REF) for SDI Playout for 
details.

Note: All 16 UHD audio channels are provided on SDI 1 and SDI 5 (model-dependent).
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Lightspeed Live Server Specifications
Telestream’s Lightspeed Live Server (see Lightspeed Live Server Specifications), is a high-
performance, high-capacity Windows platform, specifically configured as a media 
processing platform to host Live Capture and Live Stream. Telestream offers several 
models of Lightspeed Live Servers—in four and eight port configurations—to meet 
application demands and provide improved performance as technology improves.

As of the date of this publication, Telestream offers the C2+, C4 and C5 models. Other 
models are supported, but are no longer available.

Note: The Lightspeed Live Server and Lightspeed Server are different hardware 
platforms. Lightspeed Live Server hosts Telestream’s Live products, including Live 
Capture; while Lightspeed Server hosts Vantage domains.

User guides and other documentation are provided on flash drive. The same guides are 
also published on the Telestream web site.

Topics
■ Lightspeed Live Server Specifications

■ System Power

■ Drives

■ Cooling System

■ SDI Video Cards

■ Data Ethernet Network Interface Cards

■ GPU

■ Expansion Card Slots

■ RS-422 VTR Interface Kit Option

■ Front Panel

■ Rear Panel Ports and Connectors

■ SDI Video Connectors

■ SDI Audio Formats

■ Fiber/Ethernet Media LAN Connectors

https://www.telestream.net


Introduction 
Lightspeed Live Server Specifications

29

Live Capture Administration Guide

Lightspeed Live Server Major Features
This table summarizes the Lightspeed Live Server major features.

Components Description

Operating System Windows Server 2019

RAM ECC DDR4 (speed and amount vary by model)

CPU Dual Multi-Core CPUs

GPU 1 GPU

OS Drives 1 SATA SSD drive for Windows OS (top right-most slot)

1 optional OS SSD drive configured in RAID 1 (bottom right slot)

Storage Drives SATA SSD or SAS hard drives 
(capacity quantity and size vary by model)

SAS Controller Supports up to 8 SAS3 or SATA3 media drives

PCIe Option Slot 1 half-height PCIe 3.0 x8 slot or 1 full-height PCIe 3.0 x16 slot 
(model-dependent)
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SDI Video Input/
Output

Gen 1| C2 (Discontinued): One 4-port DIN 1.0/2.3 3G SDI card 
plus LTC port, for four SH/HD or one QuadLink UHD Processor; 
affinities should be balanced, and assigned affinity value 1.

C2+: One 4-port DIN 1.0/2.3 3G SDI card plus LTC port and REF 
synch port, for four SH/HD (two in and two out) or one 
QuadLink UHD Processor

OR

One dual port Mellanox ConnectX-6 Dx card.

C3 (Discontinued): Windows Server 2016 | Windows Server 
2019. One 8-port DIN 1.0/2.3 3G SDI card plus LTC port for eight 
SH/HD or 2 QuadLink UHD. Processor affinities should be 
balanced. With Preferred Processor set to Automatic, SDI 1 | 3 | 5 
| 7 are assigned affinity value 1 and SDI 2 | 4 | 6 | 8 are assigned 
affinity value 2 to maintain a deterministic balance.

OR

One 4-port BNC video card for two 12G SDI UHD in and two out, 
REF synch port.

C4: One 8-port DIN 1.0/2.3 3G SDI card plus LTC port for eight 
SD/HD or two QuadLink UHD. Processor affinities should be 
balanced. With Preferred Processor set to Automatic, SDI 1 | 3 | 5 
| 7 are assigned an affinity value of 1 and SDI 2 | 4 | 6 | 8 are 
assigned an affinity value 2 to maintain a deterministic balance.

OR

One 4-port BNC video card for four 12G SDI in or two 12G SDI in 
and two out, REF synch port.

OR

One dual port Mellanox ConnectX-6 Dx card.

C5: Dual 8-port 3G SDI. One half-height 8-port card and one full-
height 8-port card plus LTC port and REF synch port. Cards are 
bonded together to provide 8 SD/HD or two QuadLink UHD in 
and out with confidence monitoring.

C5 cards are identified as 0 and 1, and referenced in web apps 
with both the card number and port, as SDI 0:1 or SDI 1:5 for 
example. All SDI ports are permanently configured in loop 
through mode. SingleLink Loop Thru ports 0:1-0:4 loop to ports 
0:5-0:8 on card 0 and 1:1-1:4 loop to ports 1:5-1:8 on card 1, or 
QuadLink Loop Thru port 0:1 loops to 0:2 and 1:1 to 1:2. 

USB 3.0 Two front plane, two backplane USB ports

Components Description
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System Power
The chassis features redundant hot-swappable dual digital power supplies that 
automatically sense the input voltage between 100v to 240v, and operate at that 
voltage. Power cords plug directly into the power supply units at the back of the 
chassis, and the Power On/Off (0/1) button on the front energizes the unit. A green light 
indicates that the power supply is operating. When a power supply fails or is 
disconnected, an amber light on the power supply illuminates and an alarm sounds. 

Drives
The chassis supports up to eight SAS hot-swappable 2.5" disk drives. The drive bays on 
the left (viewed from the front) support SAS3 media drives, four of which are included 
as standard. You can configure these eight storage drives for RAID 0, 1, 5 or 10 (RAID 5 
set at the factory). The two additional bays on the right support only SSD/SATA drives. 
The top right bay is reserved for the Windows OS drive, and the bay below it is available.

When replacing or adding hard drives, replace with exact manufacture and model of 
drive. Drives vary by model; see Obtaining Support | Information | Assistance.

Cooling System
The system cooling design features eight 4-cm counter-rotating fans located in the 
middle section of the chassis. Fan speed is controlled by the IPMI system management 
software to respond to fluctuations in system temperature.

Data Ethernet Four 10G Ethernet 10GBase-T ports (backplane)

C5: Two RJ45 1Gb Ethernet ports (backplane, lower) and two 
10GbE with SFP+ ports.

ST 2110 Media 
Fiber/Ethernet

C2+ | C4: optional 25/100Gb Fiber/Ethernet NIC with two SFP+ 
ports for ST 2110 processing with SMPTE 2022-7 fall-back, and 
two RJ45 1Gb Ethernet ports (backplane, lower). 

When installed, you can’t install an SDI video card.

VGA Monitor One VGA monitor port

AC Power Two redundant AC inputs, 100-240 Volts, 4.5-9.5 Amps, 50-60 
Hz.

RS-422 4-port RS-422 VTR interface kits (Capture only). Optional, 
purchased separately. See Connecting VTR Systems.

Operating 
Environment

10 to 35 degrees C, 8-90 percent humidity (non-condensing)

Components Description
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Dual air shrouds direct air flow to the CPUs and other components that require cooling. 
The power supply module also includes a cooling fan.

SDI Video Cards
SDI video cards are installed in one or more PCIe card slots.

Note:  For C2+ | C4 | C5, an optional, 2-port 25/100Gb Ethernet NIC enables ST 2110 
capture. These servers support either an SDI card or a 25/100Gb Ethernet card, but not 
both in the same server.

Each of these cards provide one port for analog Linear Time Code (LTC) for use across all 
SDI input signals. As of October, 2022, the 4 and 8-port cards have an added REF synch 
port for synchronized SDI playout (see Making Data and Signal Connections).

• 4-Port 3G SDI Card (C2 | C2+)—provides four SingleLink 3G SDI ports enabling 
four SD / HD signals or one QuadLink UHD signal. Provides one LTC port. For details, 
see 4-Port 3G SDI Card.

• 4-Port 12G SDI Card (C2 | C4)—provides four UHD 12G SDI ports with BNC con-
nectors, enabling two UHD input signals and two output signals. Provides one LTC 
port. Active loop through is not supported on a server equipped with a 12G card. 
For details, see 4-Port 12G SDI Card.

• 8-Port 3G SDI Card (C4 | C5)—provides eight SingleLink 3G SDI ports with BNC 
connectors, enabling eight SD / HD signals or two QuadLink UHD signals. Provides 
one LTC port. For details, see 8-Port 3G SDI Card.

• 8-Port 3G SDI Card with Ref and LTC (C4 | C5)—provides eight SingleLink 3G SDI 
ports with BNC connectors, enabling eight SD / HD signals or two QuadLink UHD 
signals. Provides one LTC port and one REF port. For details, see 8-Port 3G SDI Card 
with Ref and LTC Connectors.

• Dual 8-Port 3G SDI Cards with Ref and LTC (C5)—one half-height, and one full- 
height card, provides sixteen SingleLink 3G SDI ports with BNC connectors across 2 
cards, enabling eight input SD / HD signals and eight output signals or two UHD 
input signals and two output signals. Both cards provide an LTC port; the full-height 
card provides a REF port. For details, see 16-Port (dual 8 port) 3G SDI Cards with Refer-
ence and LTC.

Data Ethernet Network Interface Cards
On servers Gen 1, and C2 through C4, four 10GbE Ethernet backplane ports are 
provided for network connectivity and video playback.

C4 models manufactured after October 2022 have two RJ45 1Gb Ethernet ports.

On the C5, the top two Ethernet ports (with SFP28 connectors) support 10G Ethernet. 
the two bottom Ethernet ports (RJ45) are 1G ports.
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Media Fiber/Ethernet Network Interface Cards
On the C2+ and C4, an optional 2-port, a Mellanox ConnectX-6 Dx Ethernet NIC with 
Rivermax Media Library for ST 2110 capture may be utilized. On servers equipped or 
retro-fitted with this card, SDI cards are not supported.

GPU
The on-board GPU accelerates video processing and media creation. Using the GPU in 
combination with the Lightspeed Live Server’s powerful dual CPU processors enables 
capturing media from multiple live sources.

Expansion Card Slots
Each Lightspeed Live Server provides optional full- or half-height PCIe cards, installed 
by Telestream. 

In order to ensure optimal product performance and warranty coverage, ensure that 
Telestream products are used in accordance with the following product policy. It is 
critical that this policy be adhered to when using add-in cards:

• Add-in card(s) are to be installed by Telestream, or an authorized agent, at or before 
commissioning.

• You can only use Telestream-qualified add-in cards. For the current list, refer to the 
Lightspeed Live Server product sheet on the Telestream.net web site. Using 
untested or unknown add-in cards voids the product warranty.

Note: Except for externally removable power supplies and disk drives, the Lightspeed 
Live Server has no user-serviceable parts. To maintain your warranty, any repair or 
additional PCI card installation and any service inside the sealed top cover must be 
performed by Telestream or an authorized Telestream service technician.

RS-422 VTR Interface Kit Option
The optional RS-422 VTR Interface Kit (4-port and 8-port versions) provides the ability to 
connect up to four or eight VTR units to the Lightspeed Live Server, and allows a VTR to 
be remotely controlled by the Lightspeed Tape Capture web application to facilitate 
conversion of tape-based media into digital video files.

http://www.telestream.net/lightspeed-live/techspecs.htm
http://www.telestream.net
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Front Panel
The Lightspeed Live Server has a removable front bezel. Remove the bezel to access the 
system interface buttons and LEDs, drives, and front USB ports. 

Front Panel Features
The front bezel provides visibility of the system monitoring LED indicators and allows 
pinhole access to the recessed power button. This graphic illustrates the front bezel 
and below, the bays exposed when the bezel is removed:

LEDs (left to right)
• System Overheat | FAN Fail | UID

• Network Activity (NIC1)

• Network Activity (NIC2)

• Hard Drive Activity

• Power

Power On/Off Button

The power button is directly below the LEDs. Press the power button to perform a 
normal power up/power down cycle or a hardware reboot (hold the button down for 4 
seconds). A reboot abnormally terminates connected clients and systems and should 
be done only in the event of an unrecoverable system error. Under normal conditions, 
you should close all web apps and client programs and shut down the Vantage domain 
and log out of Windows before cycling power.

UID Button (hidden)

On Lightspeed Live Servers with the bezel shown above, the UID button (which is 
mounted on the front panel immediately to the left of the power button), is hidden by 
the bezel. To utilize the UID button, first remove the bezel. The UID button alternately 
turns on and off the blue front and rear panel UID LED (far left), used to locate a 
particular unit among many units in a rack or server room.

On Lightspeed Live Servers utilizing the former bezel, the button is accessible without 
removing the bezel.

LEDs On/Off Button

2 USB 3.0

SSD/SATA OS Drive

2 or 4 drives (model 
dependent)

4 optional bay drives Optional SSD or SATA 
drive bay

UID Button
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USB Ports

Two USB 3.0 ports for general use are located below the LEDs and buttons.

Drives

The top right-most drive bay houses the SSD/SATA Windows OS drive, and the drive 
beneath it is an available SATA drive bay. These drives have their own controller, 
separate from the storage drives.

To the left of the OS drive are 8 SAS media storage drive slots containing the 4 standard 
and 4 optional media drives. These drives are configured for RAID 5 and have their own 
controller separate from the OS drive.

Rear Panel Ports and Connectors
These are the rear panel ports and connectors:

• Two redundant AC power connectors—connect to a 10-amp or greater AC source

• Four 10GBase-T Ethernet LAN ports—connect as required to LAN

• C4 (after October 2022) | C5—Two 1Gb Ethernet LAN Ports and two 10GbE SFP+ 
Ethernet ports

• Two USB 3.0 ports—connect as required to keyboard, mouse, or other serial device. 
When used for RS422 VTR control, use of a hub is not permitted.

• One IPMI-dedicated Ethernet port, which should not used for other purposes

• One VGA monitor port

• One COM control port (not used)

• One 3G SDI card with 4 | 8 ports 
OR 
One 12G SDI card with 4 ports 
OR 
C2+ | C4—One Mellanox ConnectX-6 Dx Ethernet NIC 

• C5 only—Two 3G SDI card with 16 ports total.

Note: On supported servers, one SDI card or one 25/100Gb NIC is permitted—SDI 
and Ethernet NIC cards can not be installed in the same server.

• One analog LTC port on SDI-equipped servers; none on ST 2110 servers.

• One External Ref port on selected cards manufactured after October 2022.

On supported servers, you can order additional factory -installed PCIe cards in the PCIe 
expansion slots. For details of each backplane component/connector, see Making Data 
and Signal Connections.
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SDI Video Connectors
Each Lightspeed Live Server includes one or more of several models of SDI video cards. 
Two cards are supported in Live Capture. For an overview of cards by server, see SDI 
Video Cards.

Note: On a C4 server, you can optionally install a 2-port 25/100Gb Ethernet NIC in 
place of the SDI card.

4-Port 3G SDI Card with Ref and LTC Connectors
The 4-port 3G SDI card has 6 DIN 1.0/2.3 connectors with 6 DIN 1.0/2.3 to BNC adapter 
cables (shown here right side up):

Note: The 4-port SDI card is inserted upside down into the backplane at the bottom 
right corner. Refer to imprinted labels (1 2 3 4) for SDI connection, R for Reference 
cable connection and LTC for LTC cable connection. The RS-422 port is unused.

• 4 SDI Ports (1-4): SD/HD 3G x 1080 video formats; audio 16-channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): Bi-level and Tri-level (TLS) reference input

• Linear Time Code (LTC): LTC timecode input

Ref connector

LTC connector
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8-Port 3G SDI Card with Ref and LTC Connectors
The 8-port 3G SDI card has 10 DIN 1.0/2.3 connectors with 10 DIN 1.0/2.3 to BNC 
adapter cables:

 

Note: Refer to imprinted labels (1 through 8) for SDI connection, R for Reference cable 
connection and LTC for LTC cable connection.

• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): Bi-level and Tri-level (TLS) reference input

• Linear Time Code (LTC): LTC timecode input

4-Port 3G SDI Card
The 4-port 3G SDI card has 5 DIN 1.0/2.3 connectors with 5 DIN 1.0/2.3 to BNC adapter 
cables (shown here right side up):

Ref connector

LTC connector

R connector 
for LTC
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Note: The 4-port SDI card is inserted upside down into the rear panel at the bottom 
right corner. Refer to imprinted labels (1 2 3 4) and R for proper cable connection. The 
RS-422 port is unused.

• 4 SDI Ports (1-4): SD/HD 3G x 1080 video formats; audio 16-channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): LTC timecode input

8-Port 3G SDI Card
The 8-port 3G card has 9 DIN 1.0/2.3 connectors, which you can convert to BNC with the 
included DIN 1.0/2.3-BNC converter cables. For UHD, SDI-1 through SDI-4 and/or SDI-5 
through SDI-8 (model-dependent), you can use BNC connectors to support Ultra HD 
input. 

The UHD signal is QuadLinked—connected to all four ports (SDI-1 through 4 or SDI-5 
through 8 depending on the model). All other resolutions use one port per input:

 

Note: Refer to imprinted labels (1 through 8) and R for proper cable connection.

• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): LTC timecode input

R connector 
for LTC
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4-Port 12G SDI Card
The 4-port 12G card has 5 BNC connectors:

 

Note: Refer to imprinted labels (1 through 4) and R for proper cable connection.

• 4 SDI Ports (1-4): 12G x UHD1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous for 2 input operation.

• Input Reference (R): LTC timecode input

R connector 
for LTC
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16-Port (dual 8 port) 3G SDI Cards with Reference and LTC
Two 8-port 3G cards, bonded. Each provides 9 DIN 1.0/2.3 connectors with 9 DIN 1.0/2.3 
to BNC adapter cables and is used for 4 input (1-4) and 4 output (5-8) on each card. LTC 
is provided on both cards; a REF synch port is provided on the full-height card and is 
bonded to the other, use in both cards, for synchronized SDI playout (see Using External 
Reference (REF) for SDI Playout and Making Data and Signal Connections).

In this dual-card implementation, the half-height card in the center bay is referred to as 
card 1 in web apps; card 0 is the full-height card in the right-hand bay.

8-Port 3G SDI Card with LTC

This half-height 8-port 3G card is installed in the top center bay on the C5 server, with 4 
inputs (1-4) and 4 outputs (5-8). It has 9 DIN 1.0/2.3 connectors with 9 DIN 1.0/2.3 to 
BNC adapter cables, plus a 9 DIN 1.0/2.3 connector for LTC:

 

Note: Refer to imprinted labels (1 through 8) and R for proper cable connection.

• 8 SDI Ports: SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI embed-
ded, 48 kHz synchronous. 1-4 in; 5-8 out

• Input Reference (R): Provides LTC timecode input

8-Port 3G SDI Card with LTC and REF

This full-height, 8-port 3G card is installed in the bottom right bay on a C5 server 
manufactured after October, 202, with 4 inputs (1-4) and 4 outputs (5-8). It has 9 DIN 

R connector for LTC
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1.0/2.3 connectors with 9 DIN 1.0/2.3 to BNC adapter cables, plus a 9 DIN 1.0/2.3 
connector for LTC and one for REF:

Note: Refer to imprinted labels (1-8) and R and LTC for proper cable connection.

• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous. 1-4 in; 5-8 out.

• Input Reference (R): LTC timecode input.

• Linear Time Code (LTC): LTC timecode input, bonded to other card.

R connector for LTC
LTC connector for 
timecode reference
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Fiber/Ethernet Media LAN Connectors
On C2+ and C4 servers, a Mellanox ConnectX-6 NIC card may be installed in place of the 
SDI card. It provides support for ST 2110 video, using two SFP ports: 
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Live Capture Software-Only Server Requirements
You can host Live Capture Software-only on supported servers and platforms which 
meet the minimum Vantage resource requirements intended for Live Capture 
operation.

In addition to vendor-specific requirements, the system must be configured to meet 
the general requirements of a platform being utilized to host Vantage, as specified in 
the Vantage Virtual Domain Management Guide, which is available at Telestream.net.

Compressed IP sources such as NDI, SRT, RTMP and MPEG2-TS are supported; 
hardware-based SDI and ST 2110 sources are not supported.

You should qualify your Vantage platform for expected concurrency for your workflow 
configurations before putting the platform into production—monitoring CPU, 
memory, disk throughput and GPU usage (if applicable). A safe operating range is 60 to 
80 percent peak utilization.

Topics
■ Guidelines

■ VMWare Server Requirements

■ AWS EC2 Server Requirements

Guidelines
• CPU requirements of 24 core, single or dual socket may be increased as needed for 

more resource intensive scenarios—conducting multiple concurrent recordings, 
UHD capture, or resource-intensive transcoders such as long GOP x264 based 
broadcast formats, or JPEG2000 archival, for example.

• If the host is a dual-socket system but the system is licensed for only one recording 
instance, system CPU resources may be better utilized by disabling the Live source 
channel’s Assign Processor control.

• One Capture action per workflow is allowed.

• Live Capture operates differently on systems without GPU. If a supported GPU is not 
detected by the Live Capture installer, AVC- and HEVC-based formats for both pri-
mary and secondary outputs are disabled in Capture workflows. 

• To force GPU usage, select the Enable GPU encoding option during installation. 
Tested GPU include P4000 Quadro with v471.43 drivers on Windows 2019, plus 
RX4000 and RTXA4000.

VMWare Server Requirements
VMWare ESXI Enterprise, versions 6.7-8.01 are supported and you can scale it up to four 
concurrent channels per VM. Dedicated, pass-through NVIDIA GPU’s are supported but 
not required for most media formats. 



Introduction
Live Capture Software-Only Server Requirements

44 

Live Capture Administration Guide

This table summarizes the requirements of a VMWare platform being utilized to host 
Live Capture for single-channel HD capture.

AWS EC2 Server Requirements
This table summarizes the requirements of an AWS EC2 platform being utilized to host 
Live Capture SW for single-channel HD capture.

Components Description

VMWare VMWare version 6.7, 8.0.1

RAM 16GB minimum; 32 GB+ recommended. Vantage 
consistently uses significant RAM for media 
transcoding. Telestream recommends that some or 
all memory resources be dedicated (reserved) in the 
infrastructure system.

OS Volume 100GB minimum allocated for Vantage service 
installation.

Media Storage RAW Capacity 1TB SSD vmdk or greater

Media RAID Type (default) RAID 5 or 6 recommended.

Ethernet NIC 10GbE recommended.

(see https://kb.vmware.com/s/article/1001805 

1Gb+ low-latency management connectivity and 
access to the Vantage MS SQL database instance. 
Networking infrastructure must allow for high-speed 
access to shared storage.

DNS Each instance must be addressable via forward and 
reverse DNS entries or via a local host table DNS 
record matching the Windows host name. Virtual 
instances must be reachable within 60 seconds of 
instantiation.

Components Description

RAM 16 GB minimum recommended

OS Drive 100GB SSD or greater

Media Storage RAW Capacity 1TB SSD EBS or greater

Media RAID Type (default) RAID 5

https://kb.vmware.com/s/article/1001805
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Installing & Managing Your 
Lightspeed Live Server

Installing your Lightspeed Live Server includes mounting it in an equipment rack, 
making video, network and power connections, and configuring it for operation. 
Detailed, step-by-step instructions are presented here for each of these tasks.

Other responsibilities include OS management, maintaining the server, and monitoring 
a Lightspeed Live Server during operation. These topics apply to all server models 
unless otherwise noted.

Note: For Live Capture configuration and management, see Capturing Live Video. For 
Vantage configuration for utilization with Live Capture, see Configuring Vantage and 
Updating Live Capture.

Topics
■ Installing a Lightspeed Live Server

■ Renaming a Lightspeed Live Server

■ Managing the Windows Operating System

■ Maintaining a Lightspeed Live Server

■ Setting NMOS Logging Levels

■ Managing Live Capture Logging
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Installing a Lightspeed Live Server
This topic provides instructions for unpacking a Lightspeed Live Server and installing it 
safely and securely in a computer server rack, and making the required connections.

If you purchased the optional RS422 VTR Interface Kit, you should make plans for co-
installation and VTR connection in the rack in conjunction with the Lightspeed Live 
Server. For complete instructions on installing the RS422 VTR Interface Kit and 
connecting a VTR, see Connecting VTR Systems. 

WARNING: Only trained and qualified personnel should be allowed to install, 
replace, or service this equipment.

Caution: Except for replaceable power supplies and hard drives which may be 
accessed from the outside, the Lightspeed Live Server is a sealed device, with no 
user-serviceable parts or user-accessible expansion slots. You should never open 
the top cover or attempt to upgrade or alter the server. Doing so exposes you to 
electrical hazard, may damage the unit, and may invalidate your warranty. If you 
have hardware or software problems with your Lightspeed Live Server, see 
Obtaining Support | Information | Assistance to obtain service.

Note: Before proceeding, collaborate with your network administrator to determine 
computer and network setting requirements.

Topics
■ Unpacking the Server

■ Rack-Mounting Your Lightspeed Live Server

■ Attaching the Bezel to the Chassis

■ Making Data and Signal Connections

■ Power Requirements and Connections

Unpacking the Server
The Lightspeed Live Server arrives packed in a heavy-duty, cardboard box with foam 
padding surrounding the device to protect it. During unpacking, inspect the container 
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and the contents for damage. In the event of damage, report it immediately to the 
freight carrier and to Telestream Support.

The server is heavy. Unpack the server on a strong, well-balanced table that supports 
the full weight of the server and shipping container without tipping.

Whats in the Box
Inside the main box are these items...

• Lightspeed Live Server

• Face plate

• Rack rails

• UK power cords (2)

• EU power cords (2)

• Accessory box

Inside the accessory box you’ll find these items...

• Lightspeed Live info sheet that describes the content of the USB drive, 

• USB drive with documentation & installers,

• DIN 1.0/2.3-to-BNC cables

• Rack screws

• North America power cords (2)

• Optional SFP adapters—for add-on fiber cards or Mellanox card. 

https://telestream.net/telestream-support/overview.htm
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Connecting to the Mellanox Card QSFP Ports
The Mellanox card has two QSFP ports. If you are not using QSFP28 connectors, you 
should connect SFP28 cables using the SFP adapter. Otherwise, the fiber cable inserts 
directly to the SFP/QSFP connectors.

The Mellanox card accepts Ethernet cables using these SFP connectors:

• SR - 1. Mellanox MMA2P00-ASHT Compatible SFP28 25GBASE-SR 850nm 100m 
DOM Duplex LC/UPC MMF Optical Transceiver Module

• LR - 1. Mellanox MMA2L20-AR Compatible SFP28 25GBASE-LR 1310nm 10km 
Duplex LC/UPC SMF DOM Optical Transceiver Module

• SFP56/28 Adapter. Mellanox MAM1Q00A-QSA28 Compatible QSFP28 100G to 
SFP28 25G Adapter Converter Module with DDMI.
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Rack-Mounting Your Lightspeed Live Server
The Lightspeed Live Server is designed to fit into a standard 19-inch (483 mm) 
equipment rack with support front and rear, using supplied rack rails and rear support 
extensions.

Assembling the Rails
The inner rail extensions install on each side of the chassis as shown.

Align the extension holes with the hooks on the side rail and slide the extension 
forward to engage the hooks until the quick release bracket snaps into place. For added 
stability, you can secure the extension with a screw.

Assemble the outer rails by sliding the front and rear sections together. 
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Installing Outer Rails into the Rack
Next, install the outer rails into the rack as shown in this figure: 

Proceed to the appropriate topic for your rack—round hole or square hole.

Installing in a Round Hole Rack

If your rack has round threaded holes, first remove the aluminum block at the end of 
the rail via the 2 screws, as shown here:

1. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack.

2. Extend the rear of the rail to align it with the holes on the rear of the rack (D). 

3. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack. 

Remove these two screws to 
remove the block.
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Installation in Square Hole Rack
1. Align the square pegs on the front of the rail with the square holes in the front of 

the rack (C). 

2. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack.

3. Extend the rear of the rail to align its square pegs with the square holes on the rear 
of the rack (D). 

4. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack. 

Caution: To prevent the server from falling and becoming damaged, be sure the 
rails are solidly in position and ready to support the full weight of the chassis. 
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Installing the Server in the Rack
When selecting a position in a rack to place the server, be sure to allow a minimum of 
30 inches clearance at the back of the server for sufficient cooling airflow and servicing.

To install the server, follow these steps:

1. Slide the inner rail extensions forward into the front of the outer rails.

2. Support the chassis and align the back of the chassis with the front of the rails.

3. Push the chassis backward, sliding it into the rack rails, until the chassis clicks into 
the locked position.

Caution: To prevent the server from falling and becoming damaged, be sure to 
insert it securely in the rack before you remove support.
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Removing the Server from the Rack
To remove the server from the rack, press the outer rail latch shown in the figure above 
to release the chassis.

Slide the chassis forward off the outer rails and out of the chassis.

Attaching the Bezel to the Chassis
To attach the bezel to the chassis, align the bezel’s pigtails with the holes on the front 
plane and press it into place. 

Making Data and Signal Connections
This topic describes the Lightspeed Live Server data and signal connectors and how to 
connect to them. Follow the order of connections given here, with the server powered 
down, make the following data and signal connections at the back of the server unit:

• Connect input devices (keyboard and mouse) to the USB connectors (optional).

• Connect a monitor to the VGA connector (optional).

• Make built-in Ethernet LAN connections to provide network connectivity.

• If a 25/100Gb Ethernet NIC is installed, connect to your 25/100Gb media LAN via 
SFP28 connectors.

• Connect your server to your IPMI network via the MGMT Ethernet port—Telestream 
strongly encourages using the IPMI interface to your management network for out-
of-band management and troubleshooting.

• If your server has a Mellanox ConnectX card for ST 2110 media, connect two media 
LAN Ethernet / Fiber sources to the SFP/QSFP connectors.

• If your server is equipped with an SDI card, connect SDI video sources to the con-
nectors on the SDI cards using the supplied DIN 1.0/2.3-to-BNC SDI cables.

• Optionally, on supported SDI cards, connect an analog LTC timecode source to the 
connector marked with LTC (rightmost) on the SDI card. This port is configured for 
Linear Timecode (LTC) encoded with SMPTE 12M timecode data.

Note: This input is for analog LTC only and is not intended for use as a synch 
reference.

• Optionally, for C2+ | C4 (manufactured beginning October 2022) | C5 servers, con-
nect a REF synch source to the connector marked with an R (leftmost) on the SDI 
card. 

• Optionally, connect the RS422 VTR Interface Kit to a USB port. See Connecting VTR 
Systems. 
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First-Generation (Gen 1) Rear Panel—4-Port Card (Discontinued)

C2 (Discontinued) | C2+ Rear Panel—2-Port (2 Deactivated) 3G SDI Card

C2+ Rear Panel—Mellanox ConnectX Card

C2 | C2+ Video Card PCIe Bracket

Lightspeed Live Servers equipped with Corvid 44 and 88 3G cards manufactured 
beginning October 2022, have both LTC and Reference input ports on the Corvid card’s 
backplane. Visually examine the card’s PCIe bracket to verify that your server is so 
equipped:

This enables you to use Reference input to sync SDI playout and to use the second port 
for LTC when in capture mode.

AC power Connectors

1 PCIe half-height 3.0x8 expansion slot for 
Telestream approved cards only

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port 
(dedicated)

2 USB VGACOM
Unused

LTC

SDI 4-port card

GPU 

4 DIN 1.0/2.3 
SDI ports

AC power connectors

SDI 4 port card - 4 DIN 1.0/2.3 - 2 SDI live & 2 
inactive or loop-through outputs

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port 
(dedicated)

2 USB VGACOM LTC

AC power connectors

Mellanox ConnectX Card for ST 2110

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port 
(dedicated)

2 USB VGACOM
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To utilize Reference in this manner, ensure that you have connected an analog LTC 
timecode source to the BNC connector marked with LTC, and you have connected a CB/
TLS Synch source to the R (leftmost) port on the SDI card.

C3 (Discontinued) | C4 Rear Panel—8-Port 3G SDI Card

C4 Rear Panel—Mellanox Card

C4 Video Card PCIe Bracket

Lightspeed Live Servers equipped with Corvid 44 and 88 3G cards manufactured 
beginning October 2022, have both LTC and Reference input ports on the Corvid card’s 
backplane. Visually examine the card’s PCIe bracket to verify that your server is so 
equipped:

This enables you to use the standard Reference input to sync all of your SDI outputs and 
enables you to use the second port for LTC when in capture mode.

To utilize Reference in this manner, ensure that you have connected an analog LTC 
timecode source to the BNC connector marked with LTC, and you have connected a CB/
TLS Synch source to the R (leftmost) port on the SDI card.

AC power connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port 
(dedicated)

2 USB VGACOM LTC

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports

AC power connectors

4 Onboard 10Gb 
Ethernet LAN ports

MGMT Ethernet port 
(dedicated)

2 USB VGACOM

Mellanox ConnectX card
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C4 Rear Panel—4-Port 12G SDI Card

C4 Video Card PCIe Bracket

Lightspeed Live Servers equipped with Corvid 44 and 88 3G cards manufactured 
beginning October 2022, have both LTC and Reference input ports on the Corvid card’s 
backplane. Visually examine the card’s PCIe bracket to verify that your server is so 
equipped:

This enables you to use the standard Reference input to sync all of your SDI outputs and 
enables you to use the second port for LTC when in capture mode.

To utilize Reference in this manner, ensure that you have connected an analog LTC 
timecode source to the BNC connector marked with LTC, and you have connected a CB/
TLS Synch source to the R (leftmost) port on the SDI card.

C3 (Discontinued) | C4 Rear Panel—8-Port 3G SDI Card

AC Power Connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port 
(dedicated)

2 USB VGACOM LTC

SDI 4-port card - 4 DIN 1.0/2.3 SDI ports

AC power connectors

4 onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port 
(dedicated)

2 USB VGACOM LTC

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports
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C5 Rear Panel—Dual 8-Port SDI Card Set

In this dual-card implementation, the half-height card in the center bay is referred to as 
card 1 in web apps; card 0 is the full-height card in the right-hand bay.

Power Requirements and Connections
After the server chassis has been physically installed in the rack and all data and signal 
connections made, connect the two redundant AC power cords to the back of the 
chassis and to an AC power source. Be certain to observe the following AC power and 
connection requirements and all applicable electrical codes.

The Lightspeed Live Server is rated at 100-240 VAC, 50-60 Hz, up to 10 amps. Take the 
following precautions to ensure a safe power connection:

• Make certain that the power source circuit can supply voltage within the specified 
range and current of at least 10 amps without becoming overloaded. 

• Counted together, the server and other devices connected to the same power 
source must not exceed the total capacity of the power source circuit. 

When power is connected, press the Power On/Off (0/1) button on the front of the 
chassis to turn the server on. To turn power off at any time, press the Power On/Off 
button again.

Power and General Cautions and Warnings
Observe these precautions when connecting power and operating the server:

Caution: Telestream recommends connecting computer equipment to AC power 
through an uninterruptible power supply (UPS) with surge protection. 
Fluctuations in commercial supply voltage can damage unprotected electronic 
equipment. A high quality surge suppressor may be substituted if a UPS is not 
available, but it may not provide adequate electrical spike protection.

WARNING: Only trained and qualified personnel should be allowed to install, 
replace, or service this equipment.

Hazardous high voltage electricity is present on the backplane when the system is 
operating. To prevent possible injury or death, use caution when servicing.

AC power connectors

4 onboard Ethernet 
LAN ports—2 10G 
upper; 2 1G lower

IPMI Ethernet port 
(dedicated)

2 USB VGACOM

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports

Card 1: SDI 8-port card - 8 DIN 1.0/2.3 
SDI ports with LTC port

Card 0: SDI 8-port card - 8 
DIN 1.0/2.3 SDI ports with 
LTC port and REF port
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This product relies on the building's installation for short-circuit (over-current) protection. 
Ensure that the protective device is rated not greater than 250 Volts, 20 Amps.

Ensure a proper earth ground connection to the ground conductor in the AC power plug. 
Failure to do so could present a severe electric shock hazard that could result in injury or 
death.

When installing the product, use the provided or designated connection power cables. 
Using any other cables could cause a malfunction or a fire. 

The fans might still be spinning when you remove the replaceable power supply from the 
chassis. Keep fingers, screwdrivers, and other objects away from openings in the housing.

Power supplies and other components can get very hot. Use caution when touching 
possibly hot components during operation and directly after unplugging.

This unit has two power supply connections. Both connections must be removed to 
completely de-energize the unit.
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Renaming a Lightspeed Live Server
Live Capture is a special implementation of Vantage, and the Vantage domain/array 
name is always the same as the host name of the server (or the server that hosts the 
Vantage domain database in an array).

When Windows is installed, it automatically names the computer with a random name, 
beginning with WIN- and a series of alphanumeric characters. For example: WIN-
S08Kh3N2EHG. To rename your Lightspeed Live Server, complete these tasks to ensure 
that the Vantage database is also updated with the new name:

Note: The name must be 15 character or less.

To complete this procedure, your Windows user must have permission to rename the 
computer, or you must get assistance from your Windows administrator. 

Be sure to schedule renaming during a maintenance window when no jobs are 
running, as renaming the Vantage domain interrupts all Vantage services in the domain 
(During a rename, Windows services on the server are automatically renamed as well).

To rename a Lightspeed Live Server, follow the steps outlined in the Vantage Domain 
Management Guide > Renaming a Vantage Domain. 
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Managing the Windows Operating System
Windows Server 2019 is installed on C2+, C4, and C5 Lightspeed Live Servers 
manufactured beginning February 2022. See microsoft.com for OS specifications.

Topics
■ Activating Windows with the Microsoft Activation Key

■ Applying Microsoft Updates

■ Default Windows User ID and Password

■ Web App Ports and Windows Firewall Settings

Activating Windows with the Microsoft Activation Key
One or more stickers on the top surface of the Lightspeed Live Server lists license 
numbers. The Physical Key number is the OEM license number for Microsoft Windows. If 
you re-install the OS, use this key to activate Windows again. The key contains five 
groups of five digits each. For example: YFG8H-TDD97-6BR4G-F88PF-XPF45J.

Applying Microsoft Updates
The Lightspeed Live Server ships with the Windows operating system set to check for 
updates, but it does not automatically download or install them. Downloading and 
installation of critical operating system updates is the responsibility of each customer 
(see your system administrator).

Default Windows User ID and Password
When the Lightspeed Live Server starts, log in with this Windows user account:
:

Your system administrator should change the password for security purposes.

Web App Ports and Windows Firewall Settings
The Lightspeed Live web applications use certain TCP ports that should not be blocked. 
These web apps use the following ports by default; some of which you can change:

• Live Capture—port 8083, 8084, and 8086. 
By default, selects any available port between 1024 and 65534 for the web app’s 
Live Preview display. 

• Tape Capture—port 8086

• Source Manager—port 8090

User Administrator

Password telestream!1

https://microsoft.com
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• Live Schedule Pro—port 443 and 6500

• RouteMaster—port 7777

• NDI Access Discovery—port 5960.

If you use Windows Firewall, be sure these ports are open on the Lightspeed Live Server 
and across your network.

Note: For a complete list of Vantage ports that are used and should not be blocked, 
see the Vantage Domain Management Guide > Port Requirements.

To open the Windows Firewall on the Lightspeed Live Server or other Windows 
computer, go to Start > Control Panel > Windows Firewall > Allow a program or feature 
through Windows Firewall > Allow another program.

Scroll through the list of programs, and click Add for each of these: 

• Lightspeed Live Capture

• Source Manager

• Vantage Management Console | Vantage Workflow Designer | Vantage Workflow 
Portal (Capture only) \.

Click OK to close the programs list. The added programs display in the firewall list and 
you can check which networks they can use. Then close the Control Panel.
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Maintaining a Lightspeed Live Server
These topics describes common server maintenance tasks that you may need to 
perform from time to time.

■ Performance Tuning a Lightspeed Live Server

■ Setting Your NVIDIA GPU to TCC Mode

■ Backing up a Lightspeed Live Server

■ Managing and Monitoring Lightspeed Live Servers

■ Installing New or Replacement Media Hard Drives

■ Rebuilding the Lightspeed Live Storage RAID

■ Replacing a Power Supply
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Performance Tuning a Lightspeed Live Server
The following configurations are set at the factory to ensure best performance of your 
Lightspeed Live Server. The settings are supplied here in the event they have been 
changed and you want to restore them to their original factory settings. (For details, 
consult your System Administrator or a Telestream Field Sales Engineer).

1. In Performance Options, set these Windows Performance options:

a. Navigate to Start > Control Panel > System > Advanced system settings > 
Settings button > Visual Effects tab.

b. Check Adjust for best performance.
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c. Select the Advanced tab.
d. Check Background services for Vantage transcoding service nodes and the 

domain’s Microsoft SQL database node. Select Programs for editorial systems and 
Vantage client applications that are not running other Vantage services. 

e. Select the Data Execution Prevention tab:
f. Check Turn on DEP (Data Execution Prevention) for essential Windows programs 

and services only.

g. Click OK in both dialogs to save your changes.
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2. Set User Account Control (UAC):

a.  Navigate to Start > Control Panel > User Accounts > Change User Account 
Control Settings. Set as low as safely possible, considering your exposure to 
Internet viruses and malware. Click OK to save your changes.

3. Set Power Options to High Performance with Sleep disabled:

a. Navigate to Start > Control Panel > Power Options.
b. Check the High Performance plan. 
c. Check Change plan settings, and set Turn off the display to Never. 
d. Check Change advanced power settings, and set all critical functions so that they 

are always ON (this usually means setting them to never turn off ). Click OK to save 
your changes and close the dialog.

e. Click Save Changes on the Edit Plan Settings window.

4. Disable (turn OFF) any real-time software applications and processes, such as the 
following, that could adversely affect disk I/O performance or use excessive CPU: 

– Real-time virus scanning of media files as they are being captured.

– Automatic software updates that can preempt real-time services.

– Real-time file indexing.

5. Disable all unnecessary Windows services in Start > Control Panel > Administrative 
Tools > Services (consult your System Administrator).

6. Turn OFF all firewalls (including third party firewalls) and packet filtering, which 
may cause unpredictable performance:

a. Navigate to Start > Control Panel > Windows Firewall > Turn Windows Firewall on 
or off, select Turn off Windows Firewall.

If you choose to use firewalls, open them for the applications installed on the Light-
speed Live Server.

7. You may increase network throughput by increasing buffer size in your network 
adapter. Set your Network Adapter’s transmit and receive buffers to 1024:

a. Navigate to Start > Control Panel > Network and Sharing Center > Change 
Adapter Settings > Local Area Connection > Right-click and select Properties.

8. Disable any screen savers:

a. Navigate to Start > Control Panel > Personalization > Screen Saver and select 
(None).

9. Disable disk indexing:

a. Right click on Start and select Disk Management from the pop-up menu. 
b. Right-click each disk and select Properties. 
c. In the General tab uncheck Allow files on this drive to have contents indexed in 

addition to file properties, unless you want some drives to be indexed.
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Setting Your NVIDIA GPU to TCC Mode
The NVIDIA GPU on Lightspeed Live Servers must run in TCC mode, as opposed to 
default WDDM mode: The NVIDIA GPU in TCC mode disables Windows graphics and is 
used in headless configurations, whereas WDDM mode is required for Windows 
graphics. 

When you update the NVIDIA driver, you must reset it to TCC mode to operate properly.

You can run a script to set TCC mode. The bat script (SetNvidiaDriverModelToTCC.bat) is 
in the current version’s folder.

Alternatively, perform the task manually—follow these steps: 

1. Open a Command window and execute vnvidia-smi:
cd C:\Windows\System32\ 
nvidia-smi -q

2. nvidia-smi prints the NVSMI log.

From the results, verify that the Driver Model indicates WDDM, not TCC. If TCC is 
reported, the mode is correct and you can end this task.  
Provided that WDDM is reported, locate and copy the GPU UUID—for example:
GPU UUID: GPU-4951a582-6b45-cca6-5a1c-a647130d00b1

3. Change the GPU mode to TCC by executing this command:
nvidia-smi -i GPU-4951a582-6b45-cca6-5a1c-a647130d00b1 -dm 1

using the GPU UUID from the previous result.

4. When the driver mode changes to TCC, you’ll be prompted to restart the server.

If you’re not prompted, determine the error and retry.

5. When the server restarts, run cmd.exe and execute this command again to verify 
that the NVIDIA GPU is operating in TCC mode:
cd C:\Windows\System32\ 
nvidia-smi -q

Verify that TCC mode is set properly, as indicated in the Driver Model section of the 
log:
Driver Model

     Current: TCC

     Pending: TCC

6. Close CMD and return to normal operations.
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Backing up a Lightspeed Live Server
In order to protect your Lightspeed Live Server from data loss, Telestream highly 
recommends that you create an image of the Operating System drive (C:\) drive 
immediately upon taking delivery of your server and that you perform periodic back-
ups of all critical data on the server. 

Third-party disk image products are available (for example, Acronis and Clonezilla) for 
creating a restoration image that you can use to restore the Lightspeed Live Server’s 
operating system drive to its original state. Using programs such as these, along with 
regular backups, you can restore your server back to its original shipping state with all 
of your critical data.

Consult your IT/system administrator for details on creating restoration images and 
performing a periodic backup of your Lightspeed server’s critical data.
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Managing and Monitoring Lightspeed Live Servers
IPMI View Management software provides remote network management of your 
Lightspeed Live Servers using IPMI messages over Ethernet LAN or a dedicated IPMI 
LAN. If all of the Ethernet connectors are utilized, you can use the IPMI LAN connector 
to create an IPMI network among your servers.

To download the IPMI View application and user guide, go to this web location:  
supermicro.com/en/solutions/management-software/ipmi-utilities. 

Note: Various web apps are also published which can be used to perform network 
management and monitoring tasks.

To download the IPMI View application and user guide, go to this web location:  
supermicro.com/en/solutions/management-software/ipmi-utilities. 

Tasks you can perform using IPMI View include (see IPMI View User’s Guide for details):

• Discover Lightspeed Live Servers on the IPMI network (requires IPMI LAN)

• View system event logs

• Check current sensors and monitor history of fans, voltages, temperature, and 
power supplies

• View firmware revision levels

• Perform various kinds of shutdowns and resets

• Blink the UID LED to locate a particular unit in the rack or server room

• Set fan speed

• Manage LAN configuration, SNMP configuration, and RS232 modem

• Manage users, passwords, and privileges

• Set up paging of users in the event of malfunctions

• Establish Text Console Redirection or KVM Console Video Redirection for remote 
system control via text display or full graphic display

• Access virtual media 

• Set up server management groups

• Update firmware.

For detailed instructions about using any of these system management features, 
consult the IPMI View User’s Guide.

https://supermicro.com/en/solutions/management-software/ipmi-utilities
https://supermicro.com/en/solutions/management-software/ipmi-utilities
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Installing New or Replacement Media Hard Drives
Follow these steps to replace a hard drive or install a new one. Drives may be removed 
or replaced with power on. See Drives for new or replacement drive specifications.

1. Remove the front bezel from the chassis.

2. Press the release button on the right front of the drive carrier.

3. Use the drive carrier handle to pull the carrier out of the chassis.

4. Remove the drive or dummy drive from the carrier by removing the four M3 screws 
from the underside of the carrier. Retain the screws.

5. Insert the new drive into the carrier with the PCB side down and the connector 
facing the back of the carrier. 

6. Secure the drive to the carrier with the four M3 screws retained from removal. 
Gently tighten but do not over tighten the screws, which could cause damage.

7. Slide the drive carrier into its bay with the drive facing up until it seats firmly in the 
rear connector.

8. Push the handle closed flat against the front of the carrier to secure the drive.

9. Replace the front bezel on the chassis, and go to the next topic to rebuild the RAID.
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Rebuilding the Lightspeed Live Storage RAID
The LSI Storage Authority utility program—which you start from the shortcut or from 
C:\Program Files\LSI\LSIStorageAuthority\startupLSAUI.bat on the Lightspeed Live 
Server—enables you to rebuild the storage RAID if necessary, such as when you add a 
new drive, or you want to change drive configurations. 

Replacing a Power Supply
The Lightspeed Live Server includes two user-replaceable, redundant, hot-pluggable 
power supply modules. They automatically sense the input voltage between 100v to 
240v, and operate at that voltage. Power cords plug directly into the power supply units 
at the back of the chassis. A green light indicates that the power supply is operating. 
When a power supply fails or loses power, an amber light on the power supply 
illuminates and an alarm sounds.

If either of the power supply modules fail, the other module supports the full load and 
allows the system to continue operation without interruption. The PWR Fail LED 
illuminates and remains on until the failed unit has been replaced. Replace with the 
same model. Order replacement units from Telestream. Contact Telestream Customer 
Support (Obtaining Support | Information | Assistance) to order parts.

Replacing the Power Supply
1. Unplug the AC power cord from the failed power supply module.

2. Push in the locking tab at the back of the module to release it.

3. Pull the unit straight out of the chassis. 

Caution: The power supply may be very hot when first unplugged and could 
cause burns. Handle carefully by the edges and do not touch hot components.

4. Insert the new unit into the chassis, pushing it in until it clicks firmly in place.

5. Reconnect the power cord.

AC power supplies
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Setting NMOS Logging Levels
For Lightspeed Live Servers operating in an NMOS environment, you can set the 
Capture server’s NMOS Receiver logging levels as desired. Follow these steps:

1. Open the C:\Program Files\Telestream\Live Source Server\NmosNodeConfig.json file in 
a text editor.

2. Change the logging level—the first line of the NmosNodeConfig.json file to an 
integer value between -40 (most verbose) and +40 (least verbose—only fatal 
messages). The default value is 0, which is a median level of verbosity.

For example: "logging_level" : 40,

3. Save and close the file.
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Managing Live Capture Logging
Live Capture’s log files can provide valuable information about Live Capture operations, 
including the Capture action, Tape action, and capture and tape recording jobs. 

Log files are intended for use by Telestream Customer Service to troubleshoot 
problems. Consider obtaining the log files before contacting Customer Service 
(Obtaining Support | Information | Assistance) so that you can email them to Telestream 
as part of the support process.

Topics
■ Accessing and Zipping Up Live Capture Log Files

■ Managing Log File Logging Levels

Accessing and Zipping Up Live Capture Log Files
By default, service logs are saved to C:\Program Files (x86)\Telestream\Vantage\Live\.

If a service is run as a domain user, they saved to a user-specific path, in this pattern: 
C:\Users\<Service_Account_Name>\AppData\Roaming\Telestream\ where <Service_Ac-
count_Name> is the name of the domain user.

If a service is run as Local System, log files are stored in the service’s Capture Component 
folder (there may be more than one). For example: C:\Program Files 
(x86)\Telestream\Vantage\Components\Capture.7.1.5.999999). 

Lightspeed live and tape capture log files on a job-by-job basis are written to 
C:\Windows\System32\config\systemprofile\AppData\Roaming\ 
Telestream\Capture\.

Zipping Up System Log Files
You can zip up and copy Live Capture system logs to your computer for archival 
purposes, for review, or in preparation for use in a customer service case.

To zip up log files, launch the Source Manager web app (http://[host]:8090/ (default)). In 
the More  Menu, select Download System Logs. 
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This creates a zip file on the Live Capture server and copies the zip file to your default 
Downloads directory (for example, C:\Users\<UserID>\Downloads\support.zip). The first 
file is named support.zip. The name includes a numeric suffix (support (n).zip) when 
multiple files are downloaded in the same folder. 

When the file has downloaded, the file is displayed in a panel at the bottom of the 
browser window. Click the file’s menu for options or click Show All (far right) to open 
the Downloads folder. Close the panel when done. You can open the zip file and 
examine the logs or forward the file to Telestream Support with a request for 
assistance.

Support Log Files
These log files are included in the zip file:

• Devices.csv

• EventLog-Application.evtx

• EventLog-System.evtx

• export.xml

• Processes.csv

• LiveRegistry.csv

• Services.csv

• SNMPLogs/

• Stats.txt

• versions.csv

SNMPLogs Folder

The SNMPLogs folder contains logging data from the Telestream Live Source Service:

• SourceService-[date].log.txt—Log records of activity with the sources. This includes 
loss of signal, change of format, sources being added, or sources being removed.

• LiveService-[date].log.txt—Log records of encoder failures and service startup, etc.

• packagingLog

• traceLog

SNMPLogs\traceLog Folder

The SNMPLogs\traceLog folder contains trace logs for the sources. 

• [488]-LiveSource-<YYYY-MM-DD>-log.txt (where 488 is an example PID)

• SDI 1-LiveSource-<2023-04-28>-log.txt

• HalleyComet_TS-[7792]-ChannelEncode-2023-04-26-log.txt

• Slate-LiveSource-2023-05-15-log.txt

• SRT Source-LiveSource-2022-11-21-log.txt
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Managing Log File Logging Levels
You can change the level of detail (and volume) of information written to log files by 
editing settings in the configuration files. 

Accessing Logging Configuration Files
Logging is implemented using NLog version 4.7. For details about using NLog to 
configure log file parameters, refer to https://github.com/NLog/NLog/wiki/.

Live and Tape Capture Jobs

These configuration files are in the Live Capture ComponentPac folder that supports 
Capture and Tape action recording, and the Push action (there may be more than one 
ComponentPac installed). The configuration files for logging live capture and tape 
recording processes are:

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\Capture-
Record.exe.config—specifies the live capture process logging levels.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\TapeRe-
cord.exe.config—specifies the tape process logging levels.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\TapeS-
titch.exe.config—specifies the tape process logging levels when the Vantage Tape 
action is configured with the Stitch Clips control enabled, where multiple tapes are 
used in a single job.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\Capture-
Record.exe.config—specifies the live capture process logging levels.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\Capture-
Push.exe.config—specifies the tape process logging levels.

Note: The Vantage Live Service does not utilize NLog.

There is usually no requirement to modify this configuration file, except under 
guidance of a Telestream support engineer. 

Live Preview in Source Manager

The configuration file for logging the Live Preview process, which displays video in 
Source Manager, is:

• LivePreview.exe.config—C:\Program Files\Telestream\Live Source Server\LivePre-
view.exe.config.

Telestream Live Source Service

The configuration file for logging the Live Source process is:

• LiveSource.exe.config—C:\Program Files\Telestream\Live Source Server\Live-
Source.exe.config.

By default, LiveSource process logs don’t contain the source PID in the name. 

https://github.com/NLog/NLog/wiki/Tutorial#log-levels
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If you want the Live Source Service to create a new log files each time a new PID is used 
for source when a source process restarts, modify the Live Source configuration file as 
shown here. 

Change...

<variable name="LogSuffix" value="-LiveSource-${date:format=yyyy-MM-dd}-log.txt" /> 
to 
<variable name="LogSuffix" value="-LiveSource[${processId}]-${date:format=yyyy-MM-
dd}-log.txt" />.

Caution: Before making changes to configuration files, make backups by 
copying the existing files and saving them in a safe location. 

Note: After you make changes to the configuration file, you should restart the 
services to apply the change.
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Configuring Vantage and 
Updating Live Capture

Live Capture requires Capture workflows in Vantage to serialize incoming live SDI and 
IP sources, encoding them into files. You’ll need to configure Vantage to inter-operate 
with Live Capture, and to create workflows that execute under control of Live Capture. 
You’ll also need to know how to use labels and variables between systems, and deal 
with network complexity including firewalls, UNC paths, and scaling Capture systems.

Note: Before you start using Live Capture, specific configuration is required. The Up 
and Running Checklist describes the initial configuration tasks. 
If you aren’t familiar with Vantage, browse the Vantage User Guide directly in Vantage 
Workflow Designer and the Vantage Domain Management Guide in the Vantage 
Console. Configuration details about Live Capture actions are provided directly in 
each action’s inspector, including detailed information about containers and codecs.

Topics
■ Overview

■ Up and Running Checklist

■ Previewing Sources and Finding Workflows

■ Using Live Stores for Capturing Files

■ Creating Labels and Variables for Use in Workflows

■ Updating Live Capture Software

■ Restarting the Telestream Live Source Service

■ Firewalls and Blocked Ports Limit Functionality

■ Creating a UNC Path for Resource Locations

■ Configuring Various Actions on Arrays

■ Scaling Live Capture with Multiple Servers

■ Providing Capture Sources Unique Names

■ Best Practices for Capture Array Design

■ Using Web Applications in a Capture Array

■ Using NetBIOS Host Names

■ Correcting Connection Errors in Web Apps

■ Clearing Browsing Data after Updating Vantage or Live Capture
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Overview
Configuring Vantage for use with Live Capture includes setting up certain features and 
creating Vantage Capture/Tape workflows to capture media and save it as a file. These 
one-time configuration tasks are required in your Vantage domain before you can use 
Live Capture.

The program used to perform configuration tasks is the Vantage Management Console, 
which typically has an icon on the desktop of the Vantage server or other computer 
utilized with Vantage (a node, in Vantage parlance). Later in this chapter you’ll learn 
how to use the console to perform the tasks. 

Workflows are designed and managed using another Vantage program—Vantage 
Workflow Designer—which is also launched from a desktop icon. We will guide you 
step by step in creating and activating a simple Live Capture workflow that detects your 
sources, encodes them, and places your captured files into a storage location.

Once a Live Capture workflow is activated, you’re ready to start capturing. Capture 
control is manually performed using the Live Capture web application. User-written 
programs utilizing the Live Capture API can also be used to control capture operations.



Configuring Vantage and Updating Live Capture 
Up and Running Checklist

79

Live Capture Administration Guide

Up and Running Checklist
Each Lightspeed Live Server is delivered with Live Capture and the Vantage Media 
Processing Platform (often referred to simply as Vantage in this guide) installed.

This checklist includes all of the configuration tasks you should complete to get your 
Live Capture system up and running on premises, whether you perform the work 
yourself or a Telestream Customer Service representative or Field Engineer performs 
the work for you. (Follow the links to the how-to topics for step-by-step instructions.)

Installing your Server...
Install and Connect your Live Capture Server—First, install your Lightspeed Live 
Server in a rack, make all physical connections, and add it to your Windows domain. See 
Installing & Managing Your Lightspeed Live Server.

Or, install Live Capture on your VM | cloud platform.

Note: Do not perform the remaining tasks in this checklist until you have installed 
your Live Capture Server. For support, see Obtaining Support | Information | Assistance.

In the Vantage Management Console...

Note: To learn how to perform any of these tasks, display the panel you want to use 
and click the question mark (?) button in the upper right corner of the console to 
display the topic in the Vantage Domain Management Guide.

Note: To launch the Vantage Management Console, you can use the desktop icon.

1. Add Your Capture License to Vantage—Choose Licenses (in the left panel) to 
display the Licenses tab and add the Capture license to the Vantage domain, which 
is located on the desktop in the License folder.

2.  Restart Vantage Client Programs—Restart the Management Console, and any 
other Vantage programs that may be running.

3. Enable User Administration—Configure Vantage for user management:

a. Choose Settings & Options in the left panel. On the General tab, check Enable 
user administration to enable it (required). 

b. Check Use Windows Active Directory for Users to add and maintain Vantage 
users from your network’s Active Directory instead of creating them manually in 
Vantage. (The server must part of a domain—if its in a Windows workgroup, this 
feature is unavailable).

4. Enable Open Workflows—Also in the General Tab, check Enable Open Workflows. 
Open Workflows enables serial actions in a workflow processing the growing 
output of a Capture or Tape action concurrently, reducing total workflow time.
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Note: Open Workflows is an optional, licensed feature, which you can enable in your 
Vantage domain. If your Live Capture system is joined to a Vantage domain, all Open-
capable actions in Capture and Tape workflows (those utilizing Capture or Tape 
actions) can operate in open mode, regardless of whether Vantage is specifically 
licensed to support open workflows or not.

5. Create User Accounts—Each user may optionally have their own Vantage user 
account; it is not a requirement. 

Note: User accounts can also be used to control access to the Management Console, 
Workflow Designer, Workflow Categories, and Channel Groups. Or, they can prevent 
users from competing for the same resources.

6. Configure Service Logons—By default, all Vantage and Telestream services are 
configured to use the Local System account. This account only provides access to 
files on the local Vantage domain server.  
If Vantage requires access to input or output folders on other servers (which is 
likely), you should create a user account for Vantage in your Windows domain, and 
grant access to the Vantage user account on the target server. All services must use 
the same account. Attempting to run them in different accounts results in failures.

You can configure Vantage services to log on with specific accounts in the Vantage 
Management Console or in Windows via the Services MSC. 

Telestream services must be updated directly via the Services MSC, because it is not 
a Vantage service; thus, its not listed in the Management Console. 

Note: For a full discussion of Windows authentication and service user account 
requirements, see the Vantage Domain Management Guide as well as these Vantage 
Installation Guide topics: Windows Authentication Guidelines and Setting the Vantage 
Windows Log On ID for Services. 

During workflow creation, you also must specify Open Workflows at both the work-
flow and the action level:

• Workflow Level— In Workflow Designer’s workflow details panel above the action 
selector panel, check the Open Mode option.

• Action Level—On each action, right-click and choose Workflow Mode > Open.

7. Create a Vantage Live Store—Live Capture requires at least one Live Store and 
one File Store. Choose Storage > Vantage Stores to create at least one Vantage 
Store (Live). Create a Live Store on the Vantage server’s local D drive in a Windows 
folder you choose or create: See Using Live Stores for Capturing Files for a detailed 
discussion and configuration details.

8. Create a Vantage File Store—One default store is present in Vantage. Choose 
Storage > Vantage Stores to more Vantage Stores if required. 
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9. Create Network Folders | Vantage Folders—This is optional, based on your 
workflow requirements for network server file access. 

a. Network Folders—If you plan to access network servers for input or output files, 
create/identify each location. The location should be capable of the I/O required 
for sustained reading/writing of live media. This may be a folder on the 
Lightspeed Live Server’s D drive (media drive) or a NAS/SAN. In the Capture and 
Tape web apps, you can direct the Primary and Secondary outputs to one of 
these Vantage Address Book folders.

b. Vantage Folders—Now, create Vantage folder address records in the Vantage 
Address Book to identify locations by name—Vantage Folders make it easy to 
specify the location during workflow design. Select Storage > Vantage Folder 
Address Book and add Vantage Folders.

Note: Telestream recommends that you create one Vantage Folder initially; you can 
create others as required for your workflows.

10. Authorizations—Optional; if Windows credentials are required for Vantage 
services when they access network locations in another Windows domain or 
workgroup, create Authorization records for the services to use as necessary: Click 
Settings & Options, display the Authorization tab and create authorization records. 

11. Create a Channel Group’s Nexus—Vantage uses the concept of a nexus generally, 
to organize and identify related resources and enable client applications to filter 
them. In the context of Live Capture, these resources are Vantage workflows. When 
you create a Live Capture workflow, you can associate it with a specific Channel 
Group. There is a unique nexus for each capture action—Capture and Tape.

In Capture web apps, you select one of your channel groups to display only those 
Vantage workflows in this group. Next, you choose a workflow in the channel group 
to use for the task you’re currently performing.

At least one nexus is required. The type of nexus you create depends on the web 
apps you plan to use.

Open Workflow Design Items > Nexus Definitions in the left panel to display the 
Nexus Definitions panel and create at least one Channel Group nexus: 

– Live Capture workflows (using a Capture origin action) require a Capture nexus 
and jobs are submitted (capture operations are started) directly from the Capture 
web app. 

– Tape Capture workflows (using a Tape Capture origin action) require a Tape 
Capture nexus and jobs are submitted (capture operations are started) directly 
from the Tape Capture web app.

For testing, create a nexus named Capture Nexus.

12. Restart the Vantage Live Service—To apply these settings for use in Capture, 
restart the Vantage Live Service: Display the Services tab and choose Live. Place it in 
maintenance mode (click the yellow down arrow in the toolbar) and then return it 
to Online, by clicking the green arrow. 
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In Source Manager...
Open the Chrome program and perform these configuration steps on each Live 
Capture server:

1. Start the Source Manager web app (http://localhost | <Remote Host Server 
Name>:8090).

2. Rename the SDI sources if required, then configure them (for details, see 
Configuring SDI Sources).

3. Create and configure IP sources if any are required. See relevant topics.

4. Create and configure ST 2110 sources if any are required—see Creating and 
Configuring ST 2110 Sources.

In Vantage Workflow Designer...
You should create and configure at least one workflow for each Live Capture 
application you plan to implement (Live Capture | Tape Capture).

Note: Only one Tape or Capture action is allowed in a Live Capture workflow. Multiple 
Tape/Capture actions in a single workflow is not supported.

For testing purposes, create a Live Capture workflow and configure it as described here. 
The simplest workflow has a single Capture action and uses a manual trigger, in order 
to activate a recording from the Live Capture Web App.

1. Create a new workflow, named Live Capture Test.

2. Add a Capture action from the Live category.

3. Open the Inspector and configure the following:

• Source: Select any live source you have connected to the Capture server.

• Channel Group: Capture Nexus (created earlier).

• Trigger: Manual

• Primary Output: QuickTime

• Nickname: Original

• Output Location: Vantage Store > LiveStore (created earlier).

4. Save and close the inspector.

5. Activate your workflow so that you can utilize it in Live Capture. In the Monitor 
Status tab, the Live Capture workflow you’ve activated should be listed, and state 
should indicate In Process.

See Creating Vantage Capture Workflows for Live and Tape Media for prototype 
workflows.
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In Live Capture...
Now, you’re ready to test the system... follow these steps:

1. Open Chrome and go to http://localhost | <Remote Host Server Name>/Vantage.

2. Locate your target Vantage domain, enter the default user ID Administrator (no 
password) to log in.

3. In the Vantage web portal, open the Live Capture web app.

4. Select your nexus.

5. Click Live Capture and note that there is an active channel for the workflow that 
you activated.

6. Begin capturing video. The active feeds display a preview thumbnail in the 
Channels panel of the Live Capture web app (http://localhost/Vantage/
LiveCapture.../channels/). You can activate Live Capture workflows configured with a 
manual trigger or a recurring segment trigger directly from this window.
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Previewing Sources and Finding Workflows
The Capture Inventory panel in the Vantage Management Console (VMC) enables you 
to display a preview of a Capture source, and to identify workflows which are 
configured to use a particular source. All SDI sources on a Lightspeed Live Server are 
automatically added to the Capture inventory list.

Note: Source configuration is performed using Live Source Manager (see Managing 
Video Sources). 

Select Capture Inventory in the left panel to display the Capture Inventory panel:

Note: If all input sources are not displayed after installing and starting Live Capture, 
restart the Live Capture Server. Then, check the Capture Inventory panel again for the 
list of sources. The list should be populated with all input sources after all Live Capture 
servers have been restarted. 

Previewing Sources
To preview a source thumbnail and details, click the Preview button in the Capture 
Inventory toolbar. The preview image is updated once per second.
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Finding Workflows
To determine which workflows are configured to use a specific source, click the Find 
Workflows button  in the Capture Inventory toolbar. 

The console displays a list of associated workflows:
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Using Live Stores for Capturing Files
The Capture action requires a Live Store for capturing files. 

Note: If you use other Vantage encoders in your Capture workflows, including Flip Pro 
or Media Creation, they require a file store. See Creating Stores in Vantage and Creating 
Stores, Using a UNC Path below, for implementation details.

You use a Vantage Live Store as a managed output location for Primary and Secondary 
Capture output. Live stores in Vantage are only used by Capture workflows, and are the 
only type of store that you can use in Capture | Tape workflows.

WARNING: To ensure that Vantage Live Stores manage captured media in real 
time—including deleting expired media in a timely manner by deleting files to 
preserve disk space—it is very important that Live Stores are configured 
correctly. Failure to do so may result in running out of disk space and failure of 
Capture workflows in real time.

Live Stores in Vantage refer to locations that automatically recycle expired media to 
preserve disk space in real time, improving overall system efficiency.

Note: This is a practical overview of using Live Stores from the Capture perspective. 
The creation, configuration, and management of stores, including as shares, is 
described in the Vantage Domain Management Guide. See the Vantage Domain 
Management Guide > Managing the Vantage Domain.

Each Live Store identifies a specific server and directory path (folder). Live Stores should 
be created on a Capture server’s D drive or on a server with the I/O capacity to support 
real-time write operations for best efficiency and overall system effectiveness. You can 
also create Live Stores on NAS or SAN storage systems. 

Note: For Network Attached Storage systems (NAS), the cardinal rule is to always 
create stores using UNC paths when you have a Capture array.

■ Creating Stores in Vantage

■ Creating Stores, Using a UNC Path

■ Executing Transport Actions Using Local & UNC Paths

■ Managing Live Storage Disk Space
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Creating Stores in Vantage
You create and manage Vantage Stores using the Vantage Management Console:

Creating a Live Store Folder
To create a folder for the Live Store, perform these tasks:

1. On each Live Capture server, In Windows Explorer, navigate to the D drive and 
create a local path and folder for this store. Name it LiveStore, for example. 
Alternatively, use a SAN/NAS. 

2. In Windows Explorer, select the LiveStore folder you just created and update the 
folder’s properties: 

a. Share the folder (this enables you to add aliases as well)
b. Add authorized users—your Vantage and Telestream Services users
c. Set read/write privileges
d. Set security permissions as appropriate. 

Note: In an array, the location must be a local driver letter or UNC network path and 
the Alias must be a UNC path to the same location or recycling is rendered inoperative. 
Otherwise, the Capture action must be configured with Run On rules to ensure that 
the local drive is always used on each Capture server in the array.

Click to 
display the 
Vantage 
Stores panel

Click to create a 
new Live Store

Alias must be a UNC path to the 
same location on the local server

Location—local 
path or UNC to 
same location.

Name the store to 
identify the server.

Type Set the store type.
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3. Make certain that Vantage and Telestream services are using appropriate Windows 
user accounts for accessing network locations—see Up and Running Checklist, Step 
4.

Creating a File Store Folder
To create a folder for a File Store, perform these tasks:

1. On each Live Capture server, In Windows Explorer, navigate to the D drive and 
create a local path and folder for this store. Name it FileStore, for example. 
Alternatively, use a SAN/NAS. 

2. In Windows Explorer, select the FileStore folder you just created and update the 
folder’s properties: 

a. Share the folder (this enables you to add aliases as well)
b. Add authorized users—your Vantage and Telestream Services users
c. Set read/write privileges
d. Set security permissions as appropriate. 

Note: In an array, the location must be a local driver letter or UNC network path and 
the Alias must be a UNC path to the same location or recycling is rendered inoperative. 
Otherwise, the Capture action must be configured with Run On rules to ensure that 
the local drive is always used on each Capture server in the array.

3. Make certain that Vantage and Telestream services are using appropriate Windows 
user accounts for accessing network locations—see Up and Running Checklist, Step 
4.
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Creating Stores, Using a UNC Path
To ensure that stores are accessible to Vantage and Telestream services hosted on a 
multi-server array, specify the location as a drive letter or UNC path, whether they are 
local or on a SAN/NAS. A UNC path is also required when you are using the Capture web 
apps hosted on an IIS server other than the Capture server.

Follow these steps to create and configure a Live or File Store:

1. Share the D drive in Windows.

2. Choose Storage > Vantage Stores in the left panel. The Vantage Stores panel lists all 
of the stores (two types—File and Live) in the Vantage domain. Click the New 
Vantage Store icon and specify the Location and Alias. Be sure to select Type: Live 
for your Live Stores, and File for your File Stores. For configuration details, display 
the Help topic (?) in the Management Console.

For example, for Capture servers LSL-01, LSL-02, and LSL-03, create these stores:

1. In the Alias field, add a UNC path (NOT a drive letter) pointing to the same path as 
specified in Location.

2. Create authorization records in the Vantage Management Console > Settings and 
Options > Authorization tab for each Live Store UNC path. Then put all Vantage 
services into Maintenance Mode and exit them again to apply the change.

3. When creating workflows, be sure to assign Capture actions to the Live Store 
corresponding to the Capture server where the action is executing. For example, 
assign Capture actions on LSL-01 to the LSL-01 Live Store (\\LSL-01\d\livestore).

Executing Transport Actions Using Local & UNC Paths
If a Live Store is only defined as a local path, then the Vantage Transport Service (which 
executes Transport actions) executing Copy or Move actions in a workflow must also 
run locally—on the same server as the Vantage Live Service, which executes the 
Capture, Tape, and Push actions. While they may not be necessary, Run On rules are 
often added to make sure that Transport actions always execute locally.

However, if a Live Store also specifies a UNC path that is accessible to all servers in a 
Vantage domain, then the Vantage Transport Service may run on any server in the 
array, assuming the domain is configured to use the Transport service authorized 
access to the UNC path. Details are presented in the Vantage Domain Management 
Guide.

Live Store Name Location
Store 
Type Alias

LSL-01 Local Live Store D:\LiveStore Live \\LSL-01\d\livestore

LSL-02 Local Live Store D:\LiveStore Live \\LSL-02\d\livestore

LSL-03 Local Live Store D:\LiveStore Live \\LSL-03\d\livestore
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Managing Live Storage Disk Space
Capture systems can consume significant disk space during operation. In order to 
maintain adequate disk space, Vantage enables you to manage Live Capture server 
storage automatically and manually.

In typical usage, Vantage’s job expiration is an automatic, continual means of 
controlling storage space. In addition, Vantage enables you to manually delete files 
from Live Capture server managed storage, via the Vantage Management Console. This 
is particularly useful when your Lightspeed servers are mobile—being shut down 
between capture events—for transport. 

For example, when a live music concert/event is performed, Live Capture is set up and 
started immediately prior to the start of the event, when recording begins. Then, after a 
two or three hour event, the Capture system is shut down and repacked for transport. 

This shutdown may result in multiple channels of 2-3 hours of recording on disk. 
Because the Capture system was shut down for shipment shortly after capture was 
complete, there was no time for the expiration rules to clean up storage.

Rule-based Space Management
You can set up parameters to govern automated file deletion on selected Live Stores. 

In the Vantage Management Console, display Settings & Options > Storage 
Management tab to create file deletion rules:

For configuration guidance, click the ? button to display the Vantage Management 
Guide.
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Next, in Storage > Vantage Stores, select a store, and specify the rule that applies using 
the Automated Cleanup menu:

For configuration guidance, click the ? button to display the Vantage Management 
Guide.

Workflow and Job-based Space Management
Workflow and job-based storage space management enables you to configure your 
workflows so that Vantage continually monitors jobs by age, and delete their 
associated files. 

You can set up the following automatic space reclamation options:

• Workflow Expiration—in Workflow Designer, enable this setting for your workflow 
in its settings panel) (see Viewing and Specifying Workflow Details in the Workflow 
Designer User’s Guide) to automatically delete files ingested or created by the job, 
as part of the binder deletion process.

• Expire Failed Jobs—in the Vantage Management Console Settings & Options > Gen-
eral panel (see Enabling and Disabling Expiration of Failed Jobs in the Domain Man-
agement Guide), enable the Expire Failed Jobs setting when you want failed jobs to 
be expired using the same expiration rules as jobs that complete successfully. Oth-
erwise, they do not expire automatically, and binders (and file resources) are pre-
served until deleted manually.

Manual Space Management
You may need to override the automatic space management settings on occasion, and 
perform manual cleanup. 

Using the Vantage Management Console, you can manually delete files at any time. You 
can delete all files in Live Stores, and you can also delete Live Store files by age and by 
percent of free space. 
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Manual deletion is achieved using either of these options (Storage > Vantage Stores—
right click on the target store and select Storage Cleanup or Quick Cleanup> 

• Storage Cleanup—immediately deletes all files in selected stores (Quick Cleanup for 
multiple stores) or Advanced Cleanup by date or by percent of free store space.

• Quick Cleanup—immediately deletes all files in the target store. Click OK to con-
tinue.
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Creating Labels and Variables for Use in Workflows
You can add labels and variables to the Tape action and Capture action and you can 
view and update their values in the Tape Capture, Live Capture, and Live Schedule Pro 
web applications.

Labels and variables are created and managed in Vantage. After creating a label or 
variable, you can use them in your workflows as required. For more details, click the ? 
icon or display the User’s Guide from the Help menu.

This graphic displays the Metadata Labels panel in the Vantage Management Console 
where you create and update them.

In the console, add labels using Workflow Design Items > Metadata Labels. You can also 
add variables in Vantage Workflow Designer: select Items > Variables.

Updating Vantage and External Systems with Variables
You can attach one or more variables to an event, and then, on a job-by-job basis, 
provide unique values for the variable. In the Vantage workflow, you can also save the 
variables as part of a label, along with the other workflow output in a catalog, for use in 
other workflows or for use externally, in other systems. 

Or, you can create a workflow to update metadata in external systems using variables. 
For example, you can modify your Capture workflow to enable the Update Workflow 
and provide a target workflow to trigger after each job. Now, create the target workflow 
with a Receive action (so it can be triggered) and then use Populate and Notify actions 
for example, to transfer new values to an external system.

Updating Vantage and External Systems with Metadata
You can attach one or more labels to an event, and then, on a job-by-job basis, provide 
unique values for the fields in the label. In the Vantage workflow, you can also save the 
label along with the other workflow output in a catalog, for use in other workflows or 
for use externally, in other systems. 
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Or, you can create a workflow to update metadata in external systems using variables. 
For example, you can modify your Capture workflow to enable the Update Workflow 
and provide a target workflow to trigger after each job. Now, create the target workflow 
with a Receive action (so it can be triggered) and then use Populate and Notify actions 
for example, to transfer new values to an external system.
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Updating Live Capture Software
You should only update Live Capture when you are directed to do so, as instructed by 
periodic Telestream service bulletins. You can download the Live Capture installer from 
Telestream’s support web site (see Obtaining Support | Information | Assistance).

Updating Live Capture Web Apps on Windows Workstations
To install/update Live Capture web apps on a Windows computer (other than Live 
Capture servers), IIS is required. If IIS is already installed, you must create a 
configuration that supports Vantage Web Applications.

See Installing and Configuring Vantage Web Applications in the Vantage Installation 
Guide or the Domain Management Guide for details. An easy way to access the Domain 
Management Guide is to open the Vantage Management Console and click the ? in the 
upper right corner of the main window.

The following helpful topics are in the Vantage Installation Guide and the Domain 
Management Guide:

• Server Hardware Requirements 

• Vantage Web Applications OS 

Note: Log into the Telestream Live Capture Support Portal and download the Live 
Capture installer before proceeding with these tasks to update Live Capture.

Note: After installing a Vantage or Live Capture ComponentPac update, clear the 
browsing data in your browser in order for web applications to operate properly. See 
Clearing Browsing Data after Updating Vantage or Live Capture for detailed information.

Follow these steps to install or update Live Capture web apps:

1. Copy the installer directly to the target computer or place it on a network server 
that you can access from the target computer.

2. On systems running Live Schedule, you must uninstall Live Schedule before 
uninstalling Vantage Web Applications. This is required—if you don’t, Live Schedule 
will not function after the update.

3. Uninstall the current Vantage Web Applications using the Windows Apps & 
Features Control Panel.

4. Run the Live Capture Installer and select the Vantage Web Applications Setup 
installer and proceed according to the installer directions.

https://dynamic.telestream.net/downloads/login.asp?prodid=lightspeed-live-capture&message=login
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Updating Live Capture
Use these topics to update Live Capture to the current version on your Lightspeed Live 
Server or install it or update it on other supported platforms.

Note: Log into the Telestream Live Capture Support Portal and download the Live 
Capture installer before proceeding with these tasks to update Live Capture.

All of the required files for each release are in the ~\Installer folder, located in their 
respective folders:

• \AJA Drivers and Firmware

• \Live Capture Installer

• \Nvidia\Drivers and Firmware

• \USB-Serial Drivers

• \Vantage Updates

Updating Mellanox NIC Firmware/Software
Here are the Mellanox NIC firmware and software update instructions, where the 
Mellanox ConnectX-6 Dx is installed in the free full height PCI express x16 slot, next to 
the GPU.

Required Components
• MLNX_WinOF2-23_7_50000_All_x64.exe

• Rivermax_1.31.10_installer.msi

• WinMFT_x64_4_25_0_62.exe

• ConnectX6Dx_FW_22_38_1002.bin (for 25 GbE Mellanox hardware, model MCX-
623102AN)

• ConnectX6Dx_MCX623106AN-CDAT_FW_22_38_1002.bin (for 100 GbE Mellanox 
hardware, model MCX623106AN)

Installation Guidelines
• If upgrading from a previous release, uninstall Rivermax ST2110 stack, Mellanox NIC 

drivers, and WinMFT.

• Install Mellanox NIC driver: MLNX_WinOF2-23_7_50000_All_x64.exe

• Install Rivermax ST2110 stack: Rivermax_1.31.10_installer.msi

• Licensing: The rivermax.lic (issued by the licensing department for the purchase) 
must be in C:\Program Files\Mellanox\Rivermax\lib\

• Firmware Upgrade: Install with WinMFT_x64_4_25_0_62.exe to install the Mellanox 
Firmware Tools to burn the firmware. The required firmware version for Live Source 
is 22_38_1002.

https://dynamic.telestream.net/downloads/login.asp?prodid=lightspeed-live-capture&message=login
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Using Mellanox Firmware Tools

Open a Command Prompt window with administrator privileges, and run C:\Program 
Files\Mellanox\WinMFT\mst status -v to find the MST device ID

The command returns bus data from the NIC, similar to this:
mt4125_pciconf0 bus:dev.fn=02:00.0

mt4125_pciconf0.1 bus:dev.fn=02:00.1

In this example, mt4125_pciconf0 is Mellanox ConnectX-6 Dx Adapter and 
mt4125_pciconf0.1 is Mellanox ConnectX-6 Dx Adapter #2.

Note: The device ID of the card that is to be flashed is 4125. Do NOT flash NIC cards 
with another ID (for example, mt4127.)

Burn firmware using the following commands, one by one:

flint -d mt4125_pciconf0 -i ConnectX6Dx_FW_22_38_1002.bin burn
flint -d mt4125_pciconf0.1 -i ConnectX6Dx_FW_22_38_1002.bin burn

Note: For systems with a 100 GbE Mellanox NIC installed (MCX623106AN,) use the 
ConnectX6Dx_MCX623106AN-CDAT_FW_22_38_1002.bin file.

After updating, re-enter the network settings for the Mellanox adapters.

Nvidia Graphics Driver Installation Steps
If a new version of the NVIDIA Graphics driver is required:

1. Uninstall the NVIDIA Graphics Driver via the Windows Apps & Features Control 
Panel.

2. Install the driver for your Lightspeed Live Server using the installer in 
Installers\Nvidia\. Using the Advanced options > Clean Install is recommended.

3. After updating the NVIDIA driver, be sure to reset your GPU to operate in TCC mode 
(see Setting Your NVIDIA GPU to TCC Mode).

Nvidia AJA Driver & Firmware Installation Steps
If a new version of the AJA driver for Corvid-based SDI capture is required:

1. Uninstall AJA NT2V Drivers from Windows Apps & Features Control Panel

2. Install new AJA driver from the installer located in the Installers\AJA Drivers and 
Firmware\Driver\ folder.

If a new version of AJA firmware is required:

1. Open cmd.exe and change the directory to Installers\AJA Drivers and 
Firmware\Firmware\.

2. Identify the BIT (~.bit) file appropriate for your Corvid hardware.
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3. On a single Corvid card system run ntv2firmwareinstaller -p 
[corvid_999.bit] where 999 is the version number.

4. For a system with multiple Corvid cards, direct the target of the update with the -d 
argument. For example: 
ntv2firmwareinstaller -d0 [corvid_xxx.bit]

ntv2firmwareinstaller -d1 [corvid_xxx.bit]

5. Power down the system and restart it, to enable the system to initialize the cards 
with the new firmware.

Updating | Installing Live Capture Software
This topic describes updating or installing Live Capture on your Live Capture server. 

For Live Capture Software licensing requirements, see Software-Only Licensing.

For supported platforms and minimum platform requirements, see Live Capture 
Software-Only Server Requirements.

All of the required files for each release are located in the Installer folder:

• Live Capture Installer

• Vantage Updates

• Driver and firmware installation
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Installation Steps
To update the Live Capture software:

1. Install Vantage if required—see the Vantage Domain Management and Installation 
Guide on the Telestream web site.

Configure the installer to install these services:

– Vantage Analysis Service

– Vantage Avid Service

– Vantage Cloud Service

– Vantage Transcode Service—you should not install this service if the Capture 
server is going to be added to an existing Vantage domain.

– Vantage Communicate Service

– Vantage Metadata Service

– Vantage Monitor Service

– Vantage SDK Service

– Vantage Transport Service

2. If a new Vantage Update Pack is required, run the installer from the Vantage 
Updates folder.

3. Install Live Capture using the installer in the Live Capture Installer folder and follow 
the steps in the installer.

4. On the Installer Options panel:

– Disable Automatic Registry configuration—The installer creates the required 
registry settings automatically. Generally this setting should unchecked so that 
the registry settings are created, but you can enable it if you are making the 
required registry settings prior to installation.

– (Software Only Capture) Enable GPU Encoding—This is for software-based Live 
Capture systems—VM | cloud, for example. The installer automatically enables 
GPU support on the target system if it detects a GPU. If no GPU is detected, you 
can enable this setting to force GPU support. 

Note: Note: if GPU emulation on the VM is not supported or not correctly configured, 
this causes Capture jobs to fail.

– Clean Install—Enable to reset the Source Manager etcd database to default 
values. 

Caution: Clean installation of Live Capture deletes all Live Source settings.

5. Click OK to perform the installation per your settings.

6. Restart the server.

Installing Live Capture

https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/8-1/Vantage-Domain-Management-Guide.pdf
https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/8-1/Vantage-Domain-Management-Guide.pdf
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To update the Live Capture software, follow these steps:

1. Uninstall Telestream Live Capture using the Windows Apps & Features Control 
Panel.

2. If a new Vantage Update pack is required, run the installer from the 
Installers\Vantage Updates folder.

3. Install the new version of Telestream Live Capture from the Installers\Live Capture 
Installer folder and follow the steps in the installer.

4. On the Installer Options panel:

– Disable Automatic Registry configuration—The installer creates these settings 
automatically. Generally this setting should be left disabled, but you can enable 
it if the installer will be making the required changes prior to installation.

– (Software Only Capture) Enable GPU Encoding—for VM-based Live Capture 
systems. When checked, the installer enables GPU support on the target system 
if it detects a GPU. If no GPU is detected, you can enable this setting to force GPU 
support.

– Clean Install—Enable to reset the Source Manager etcd database to default 
values. Note: Performing a clean installation of Live Capture deletes all Live 
Source settings and you must recreate them.

5. Restart the Live Capture server.
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Restarting the Telestream Live Source Service
If you changed server settings to join an array or change port numbers, the Telestream 
Live Source Service should be stopped and restarted to operate under the new 
settings.

For a single Live Capture server, stop and restart the Live Source Service.

To restart Capture servers in an array, follow these steps on each server in the array:

1. On each server except the Vantage database server, open the Services control 
panel and stop the Telestream Live Source service.

Note: In Task Manager, make sure that the processes supported by the services have 
also terminated before continuing. It may take a minute for source processes to 
terminate before you can start the Vantage Live Service again. You may need to 
manually terminate the Live Source process.

2. Now, restart the Live Source Service. 

3. Shut down and reboot the Vantage domain server.

The sources from all Live Capture servers should now display in the Live Source 
Manager web app.

Firewalls and Blocked Ports Limit Functionality
If you have firewalls and/or blocked ports you may not be able to access each of the 
Live Capture servers in an array. The servers display, but, for example, you may not be 
able to configure Channel settings or view the sources.

Telestream recommends that you disable the Windows Firewall on all computers that 
communicate with or support Telestream and Vantage services. The default Windows 
Firewall configuration blocks access to a Vantage server from other Vantage 
components, such as other Vantage servers or workstations running Vantage client 
software. 

For details about firewalls and port usage in Capture, see Web App Ports and Windows 
Firewall Settings. For information about firewalls in Vantage, also see Firewall Guidelines 
in the Vantage Domain Management Guide. 

Creating a UNC Path for Resource Locations
When multiple Live Capture servers are joined together, you should specify the 
Resource Location for assets as a UNC path. This allows different servers to access the 
assets used for segment materials. See Using Live Stores for Capturing Files for details.
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Configuring Various Actions on Arrays
A Live Capture license includes a Vantage array license. When a Live Capture workflow 
executes, the Capture (an origin) action process executes on the local Live Capture 
server. However, other Vantage services—such as Vantage Transport and Deploy 
services—can run on any server that has the required resources for the service.

You can optionally implement Run on Rules to ensure that these actions run on the 
same server as the capture, to simplify workflows. See the Vantage Domain 
Management Guide and Vantage User’s Guide for information about creating and using 
Run on Rules. 

When Capturing to a Live Capture Local Media Drive

When you are using a Capture action to capture directly to a Live Store that is 
configured to write to a local drive, Vantage auto-generates Run on Rules for the 
workflow actions following the Capture action that operate on the output of the 
Capture action to execute directly on the same Capture server. You may also set up 
manual Run on Rules to make this limitation clear in the workflow.

If you specify that the capture output is to be written to a UNC folder, Run on Rules are 
not generated, and subsequent actions which operate on the capture output may be 
executed anywhere, unless you establish Run on Rules to the contrary.

For actions that do not immediately follow the Capture action, best practice is to set 
Run on Rules that instruct processes for actions other than Capture to run on the Live 
Capture server where the media resides. See Configuring an Action’s Run on Rules in 
the Vantage User Guide for more information.

When Capturing to Shared External Storage

When you are capturing to a shared external storage location, such as a NAS or SAN 
with Capture as part of a larger Vantage array, you can execute the transport actions on 
any server with available resources. In this case, Run on Rules are not required. Your 
system automatically chooses an available service on any server that can execute the 
required action.

See Scaling Live Capture with Multiple Servers for information about setting up a Vantage 
array for Live Capture. See also Using Live Stores for Capturing Files for more details.
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Scaling Live Capture with Multiple Servers
Your Lightspeed Live Server is factory-configured as a standalone Live Capture system, 
including a Vantage domain, with Vantage services, client applications, and the 
Vantage database). If you plan to create an array of multiple Lightspeed Live Servers, or 
add Live Capture servers to a Vantage array, you can do this in two ways: 

• For Capture-only systems, join all Live Capture servers together by creating an array 
that utilizes a single Vantage domain database. 

• For Capture systems that use other Vantage services and workflows, such as 
Transcoding and Analysis, add your Live Capture servers to the existing Vantage 
domain.

Connecting Multiple Capture Servers to a Vantage Domain
Vantage database and Live Capture web application traffic can affect Live Capture 
server performance. Therefore, either as a Capture-only Vantage array or a single-server 
Vantage domain, Telestream recommends that the Vantage database and IIS hosting 
the Live Capture/Vantage web applications run on a dedicated server. See images 
below and Best Practices for Capture Array Design.

Further information regarding running the database and IIS on non-Live Capture/
Vantage servers is located in the Vantage Domain Management Guide. 

It is also highly recommended that the process of creating a Vantage domain with Live 
Capture servers be performed as part of the installation and commissioning phase.

Note: When two or more Live Capture servers are combined into an array or joined to 
an existing Vantage domain, only those ComponentPacs that are installed on the 
server hosting the Vantage database are utilized.  
Verify that all of the required ComponentPacs are installed on the Vantage database 
host. 
The Vantage Transcode Service should be uninstalled from Live Capture servers, using 
the Vantage Management Console. To preserve optimum live capture performance, 
you should not perform additional Vantage transcoding on Live Capture servers. 

https://telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Joining Capture-Only Systems
You can join two or more Lightspeed Live Servers together to form a multi- server Live 
Capture-only system. This allows for common configuration, management, and capture 
control.

  

To join Lightspeed Live Servers together, follow these steps:

1. Select one of your Lightspeed Live Servers to act as the Vantage domain database 
server. The domain database server hosts the domain database and has all the 
services running on other Lightspeed Live Servers added to it via the Vantage 
Management Console. 

2. Add all services running on your Lightspeed Live Servers to the Vantage domain, 
using the Vantage Domain Management Console. See the Vantage Domain 
Management Guide for details on adding services.

3. Add the appropriate multiple-server Vantage license to the domain. See the 
Vantage Domain Management Guide for details on licensing. 

To configure, manage, and control your system, connect the Vantage Management 
Console, Vantage Workflow Designer, and Live Capture web applications to the domain 
named with the same name as the database server selected in Step 1, above.

Also see, Configuring Various Actions on Arrays. 
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Existing Vantage Array—Adding Live Capture Servers
Joining Lightspeed Live Servers to a Vantage array enables Vantage workflows to begin 
with a Capture origin action that is connected to other Vantage actions and services, 
such as general transcoding, IPTV/VOD transcoding, analysis, third party application 
control, delivery options, or other service/action types.
   

Adding Services

The Lightspeed Live Server hosts Vantage services, so adding these services to an 
existing Vantage array is no different than adding any other Vantage service running on 
a separate server to a Vantage array. 

Important Note: Joining Live Capture services to an existing Vantage array requires 
specific Vantage array licensing. See the Vantage Domain Management Guide for 
details.

To add Live Capture services to a Vantage array, follow these steps:

1. Verify that the Live Capture services are running, all Vantage Services are running 
on the server, and no jobs are being processed in the local, factory-installed all-in-
one domain.
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2. Verify that you have configured the other (non-Lightspeed) Vantage domain server 
with the array, and is running. Refer to the Vantage Domain Management Guide > 
Installing a Vantage Distributed Domain, for more details.

3. Verify that the Lightspeed Live Server is on the same network as the Vantage array, 
with sufficient network permissions and access. Refer to the Vantage Domain 
Management Guide > Network Requirements, to configure your network. 

4. Start the Vantage Management Console, and select the new Vantage array.

5. Add the services on the Lightspeed Live Server to the new Vantage array, just as 
you would do with any Vantage services running on any Vantage server. Refer to 
the Up and Running Checklist for configuring services with appropriate Windows 
user accounts.

6. Apply the appropriate Vantage array license onto the system running the Vantage 
domain database. See the Vantage Domain Management Guide for details on 
licensing.

Also see Configuring Various Actions on Arrays.
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Providing Capture Sources Unique Names
It is a requirement that each capture source has a unique name when multiple Live 
Capture servers are part of an array. You should change the default source names to 
make them unique and identifiable in the scope of the array. 

By default, Source names are named SDI [1 through n], where n is 4 or 8 depending on 
server. For example, SDI names for a 4-channel server are:

SDI 1 | SDI 2 | SDI 3 | SDI 4

If you change source names using the Source Manager (Managing Video Sources), keep 
in mind that all sources in an array must be uniquely named so you can easily 
distinguish sources on one server from sources on another.
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Best Practices for Capture Array Design
The best practice for using multiple Live Capture server systems (an array) is to install 
and run the Vantage domain database and IIS on a dedicated server, separate from the 
Vantage and Live Capture servers. See the Vantage Domain Management Guide for 
details on installing a Vantage database and IIS.

When clustering two or more Live Capture and Vantage servers together, best practice 
is to use a separate server designated as the IIS web server to host the Live Capture web 
application. Ideally, the web host should be separate from the Vantage domain 
database since both IIS and SQL can consume a considerable amount of system 
resources. 

The following are two example systems utilizing a dedicated Vantage database and IIS 
web server.

Capture-only System

 

In this example, the Vantage domain database and IIS are installed together on a 
dedicated server. This prevents database and web server resources consumption from 
affecting the Live Capture servers.
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Capture Array—Separate Vantage Database and IIS Web Servers

In this example, the Vantage domain database and IIS are each installed on dedicated 
servers. 

 

Since this is a large system, containing six Vantage systems and three Live Capture 
servers, hosting the database and web server separately from all other servers running 
Vantage services is recommended to prevent overhead resource consumption from 
affecting the Live Capture and Vantage servers.

For additional information on best practices for Vantage and Vantage databases, refer 
to the Vantage Domain Management Guide and the Planning and Setting Up Your 
Vantage Database publication on the Telestream web site.
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Using Web Applications in a Capture Array
When you have multiple Capture servers in an array—where the Vantage database and 
web server typically are hosted on different, dedicated server(s)—Vantage client 
applications and/or Live Capture web applications must be configured to connect to 
Vantage via the database server.

Configuring Vantage Client Applications for Multiple Servers 
Connect to your domain by selecting the database server in the Select Vantage Domain 
dialog in each Vantage client program:

Using Vantage Desktop Client Applications

First, install the Vantage Management Console and Vantage Workflow Designer client 
applications on any Windows system on your network. To use these client applications, 
you must change the Vantage Domain so they connect to the server that is running the 
Vantage domain database. 

Select Change Vantage Domains from the File menu of each client application to open 
the Select Vantage Domain dialog.

Note: To learn more about the Vantage Management Console or Vantage Workflow 
Designer, click the ? icon to display the topic for the feature that you are using. Or, use 
the Help menu to open the searchable Vantage User Guide for general help.

Using the Live Capture Web App to Manage Multiple Servers
To use the Live Capture web application with multiple servers, first install the Vantage 
web applications on the server hosting the IIS Web Service. 
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To open the Live Capture web application, use the following URL:

http://<IIS Web service Host Name>/Vantage

... where <IIS Web service Host Name> is the DNS name of the computer hosting 
the IIS Web Service.

Vantage displays the Select Vantage Domain dialog:

In the Name or IP field, enter the server hosting the Vantage domain database and click 
OK to log in. 
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Using NetBIOS Host Names
You can use a Vantage array without an external name server, when NetBIOS is enabled 
in the database server and all nodes.

Note: NetBIOS only resolves names of Windows computers on the local subnet. If 
there are client or host systems on multiple subnets or you are using clients on other 
platforms, you must use DNS or a local hosts table.

Configure the following settings in all servers to enable NetBIOS:

1. Open the Control Panel and select Network and Sharing Center.

2. Select the Change Adapter Settings option to open Network Connections.

3. Right-click on the network connection to change and select Properties. The 
Properties dialog displays:

4. Select TCP/IPv4 and click the Properties button. The TCP/IPv4 dialog displays:
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5. Configure the IP Address, unique for each server.

6. Configure the Subnet Mask, Default Gateway, and the DNS server address settings. 
Use the same addresses for each server. 

7. Click the Advanced button. The Advanced TCP/IP Settings dialog displays:

8. Select the WINS tab, then select Enable NetBIOS over TCP/IP. 

9. Click OK in all dialogs to save the configuration.

10.  Reboot the server you just configured, then configure all other servers. 
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Correcting Connection Errors in Web Apps
When using Live Capture web applications on a workstation and connecting to a 
Capture server via the network, you may experience connection problems if you aren’t 
using DNS. 

Note: Name resolution is required for all computers in a Capture system—via 
NetBIOS, DNS, or local hosts tables.

For example, you may see a No Event message instead of video thumbnails. 

To facilitate connections on servers | workstations that do not utilize external DNS:

• Capture arrays require connections using host names, not IP addresses

• If external DNS is not available, host name resolution should be configured as 
described following.

Update the hosts file on the computer you’re using to run the web apps. This procedure 
describes how to correct this problem for Mac OS and Windows workstations.

Sample hosts File
Here is an example hosts file (whose content is identical for MacOS and Windows), 
showing various servers in a multi-server, Live Capture domain:

# SAMPLE LIVE CAPTURE DOMAIN

   16.160.26.57 Capture--Anaheim-57 # Vantage database

   16.160.26.55 Capture-LS-Anaheim-60 # Vantage Services

   16.160.26.19 Capture-LSLC4-Northridge-17 # Live Capture Service

   16.160.26.18 Capture-LSLC4-Burbank-103 # Live Capture Service

   16.160.26.25 Capture-LSLC5-Burbank-104 # Live Capture Service

   16.0.20.72 LS-Burbank-64 # Web apps server

Here is an example hosts file with a single entry, for a computer workstation which is 
running Live Capture web apps—an operator, fore example—which identifies the IIS 
web server:

   16.0.20.72    LS-Burbank-64    # Web apps server

Updating the hosts File on Mac OS
On a Mac OS computer, add each server IP address and host name to the ~/etc/hosts file 
and save it. Perform these steps:

1. Open the Terminal application—go to Application > Utilities and double-click 
Terminal.app.

2. Enter sudo nano/etc/hosts and press Return.

3. Enter the administrator password for the computer and press Return.
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4. Place the cursor after all of the text in the window and type the IP address of your 
Live Capture server. For example: 102.54.94.97

5. Press the Tab key, then type the host name of the Live Capture server. For example: 
CaptureServer1

6. Hold down the Control and 0 keys and press Return. 

7. Press Ctrl-x to exit.

8. Flush your DNS table by executing sudo killall -HUP mDNSResponder in Terminal.

9. Quit the Terminal application. 

Updating the hosts File on Windows
On a Windows computer, add each server IP address and host name to the hosts file 
and save it. Perform these steps: 

1. In File Explorer, navigate to: C:\Windows\System32\drivers\etc. 

2. Open the hosts file in Notepad.

3. On a new line, enter the IP address of your Live Capture server.

For example: 102.54.94.97

4. Press the Tab key and enter the host name of your Live Capture server.

For example: CaptureServer1

5. Save the file and close Notepad.
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Clearing Browsing Data after Updating Vantage or 
Live Capture

After you have performed a Vantage version upgrade or ComponentPac update on 
your Live Capture server or other Vantage domain being used in conjunction with Live 
Capture, you should clear the browsing data in your browser in order for the Live 
Capture web applications to operate properly. 

Follow these steps to clear the browsing data:

1. In Chrome, select Clear browsing data... from the More menu to display the Clear 
browsing data dialog.

2. Select The beginning of time from the Obliterate the following items menu, then 
check Cookies and other site and plugin data and Cached images and files.

3. Click the Clear Browsing Data button,
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Installing | Updating Live 
Capture

Telestream periodically updates Live Capture. This chapter provides a checklist of the 
tasks to perform to update your Lightspeed Live Server with the current version.

This chapter also describes how to install Live Capture Software Only on a VM platform.

These checklists identify the tasks to perform, not how to perform them. For advanced 
procedures, a detailed reference topic is provided. 

Topics
■Obtaining the Live Capture Installer

■Updating Lightspeed Live Capture

■Installing Live Capture SW on a Virtual Machine

■Updating the Mellanox Card
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Obtaining the Live Capture Installer
To obtain the current Live Capture installer, follow these steps:

1. Go to the Telestream Download Center and log in with your authorized user name 
and password.

2. Click Download to copy the Live Capture ZIP file to your computer.

3. When download is complete, go to your Downloads folder and copy the Live 
Capture ZIP file to each Lightspeed Live Server that you plan to update.

Updating Lightspeed Live Capture
Lightspeed Live Servers ship with Live Capture and Vantage pre-installed.

Note: Ensure that the C drive has at least 5GB free space available after installation. 
Inadequate free space can cause unpredictable Live Capture behavior, including 
inability to add sources. At least ten percent of the total drive space should be free, as 
a general guideline.

This checklist identifies the tasks that you should perform when you initially install your 
Lightspeed Live Server(s) to verify that all software components are up to date and 
operational, or to update a previous version of Live Capture to the current version.

If you have a Live Capture array, these tasks pertain to each server in the array.

Quiesce the Lightspeed Live Server
1. In Vantage Workflow Designer, wait for current capture jobs to complete or stop 

them.

a. To stop capture jobs in Live Capture or Tape Capture, halt the capture operation. 
b. In Live Schedule, halt any scheduled captures that are planned during this 

downtime.
c. In Vantage Workflow Designer, deactivate all Capture and Tape workflows.

Verifying DNS Resolution
2. Verify that DNS resolution is functioning. If the server is not in DNS, hosts files 

should be configured on the server and clients.

Note:  You may get a false sense that DNS is working when it is not—Windows 
computers on the same subnet will resolve based on NETBIOS. However, NETBIOS 
doesn’t operate across subnets or on workstations other than Windows.

• For servers with DNS:

Open a command prompt or PowerShell (Windows) or Terminal (OSX/Linux) and 
perform nslookup both ways—forward and reverse—both are required.  
For example: nslookup lsl-Capture1 and nslookup 10.0.23.143.

https://dynamic.telestream.net/downloads/download-lightspeed-live-capture.asp?prodid=lightspeed-live-capture
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• For servers without DNS:

Create/update the hosts file:

Windows: C:\Windows\System32\drivers\etc\hosts

OSX/Linux: /etc/hosts

Install Live Capture
3. Unzip the Live Capture ZIP file that you downloaded and copied to the server. It 

contains these folders:

• Documentation—user guides, app notes, data sheets, and release notes

• Installers...

– AJA Drivers and Firmware

– ipmitool

– Live Capture Installer

– LSA-Raid

– Mellanox

– Nvidia

– USB-422-set-pin-high

– USB-Serial-v2.12.24-Drivers

– Vantage8.1U5

• SNMP—MIB files and readme

4. Use Windows > Programs > Uninstall or Change a Program to uninstall Telestream 
Live Capture and Telestream Live Source (and their services) from the server before 
installing the new version.

5. Run the Telestream Live Capture Setup installer and follow the instructions. The 
installer package contains the appropriate drivers and firmware, however it does 
not install them.

6. When Live Capture installation completes, the installer prompts you to restart the 
server. 

Note: If you logged in with a user ID other than local user Administrator, the system 
won’t restart. This is due to default security policies in Windows server. Restart 
manually or—as system administrator—set the Shut down the system local security 
policy to allow the logged in user to restart the server.

7. In the Window Administrative Tools > Services, verify that these updated 
Telestream services are installed and started:

– Vantage Live Service

– Telestream Live Source Service.

8. Ensure that all Telestream services are running as the same user, with proper file 
access authority.
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9. Update the NVIDIA driver if a new version is required.

In Windows > Programs > Uninstall or Change a Program, compare the NVIDIA 
Graphics Driver <999.99> program (for example, V535.98) to the Live Capture 
3.6.2\Installers\Nvidia\C2-C3-C4\ driver’s exe file version (for example, 535.98-
nvidia-rtx-winserv-2019-2022-64bit-international-dch-whql).

If the installer’s version is new (a higher version number) than the installed driver’s 
version, uninstall the NVIDIA Graphics Driver from the Windows Apps & Features 
control panel and install the driver for your Lightspeed Live Server from Install-
ers\Nvidia\C2-C3-C4-C5. Advanced options > Clean Install is recommended.

a. After updating the driver, be sure to set the GPU to TCC mode—see Setting Your 
NVIDIA GPU to TCC Mode. 

10. Install AJA drivers on your Corvid card when a new version is required:

a. Uninstall the AJA NT2V driver from Windows Apps & Features control panel
b. Install new AJA driver from Installers\AJA Drivers and Firmware\Driver\.

11. Install AJA firmware if a new version is required:

a. Run cmd.exe and change directory to Installers\AJA Drivers and 
Firmware\Firmware\

b. Identify the *.bit file appropriate for your Corvid card.
c. Run ntv2firmwareinstaller -p [corvid_xxx.bit].
d. Power down and unplug the Lightspeed Live Server for at least 2 minutes, and 

restart it to enable the card to initialize with the new firmware.

12. Launch the Live Stream web app from a client workstation using a host name (not 
localhost) to verify DNS resolution: http://<HOSTNAME>:8089.

13. In the Live Stream web app, perform initial SDI source testing:

a. Verify SDI port connections on the Lightspeed Live Server.
b. Confirm all SDI inputs are present and show valid video. 
c. Edit configurations for each SDI input to set bit depth, timecode source, PsF, etc.
d. Disable loop through and free run timecode.
e. Set only frame-accurate timecode sources (LTC | Source). Computer clock is not 

frame accurate and is rarely adequate.

LTC is obtained from the LTC port, thus is common to all SDI inputs—you can not 
use different LTC sources. When using LTC, you may need to increase timecode 
level/amplitude to obtain a valid signal.

14. Log in with your credentials (default admin/live!).

15. See Live Capture User Guide > Configuring SDI Sources to set up an SDI stream and 
confirm that you can preview it and start streaming.

For a group only...

16. Back in Group Portal, remove the server from maintenance mode.
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Updating Vantage
You should audit Vantage to verify that it is up to date—and update it if required—
before updating Live Capture. 

Follow these steps:

1. In the Vantage Management Console, display Help > Database and verify that the 
version is 8.1.0.

2. In Windows > System > Apps & Features verify that Vantage 8.1 Update Pack 5 is 
installed.

3. If any of these are earlier than the minimum required version, proceed to Updating 
Live Capture Software.

Installing Live Capture SW on a Virtual Machine
You can install Live Capture Software Only edition on a Windows Server2019 virtual 
machine (VM), and is intended as a resource-limited scaling of Live Capture capacity. 
The VM platform must meet baseline requirements—see Live Capture Software-Only 
Server Requirements for details.

Live Capture VM licensing allows one active Vantage Capture workflow per license, 
excluding the use of GPU-based encoders for AVC and HEVC formats for primary or 
secondary output in Capture workflows. See Software-Only Licensing.

If Live Capture is licensed for a single active workflow, system CPU resources may be 
better utilized if the source channel’s Assign Processor control is disabled. See Live 
Capture User Guide > Configuring SDI Sources to disable Assign Processor (if displayed 
in the panel—model dependent).

1. When Live Capture installation completes, the installer prompts you to restart the 
server. If you logged in with a user ID other than local user Administrator, the 
system won’t restart. This is due to default security policies in Windows server. 
Restart manually or (as system administrator), set the Shut down the system local 
security policy to allow the logged in user to restart the server.

Updating the Mellanox Card
Use this topic to install a Mellanox ConnectX-6 Dx NIC Card in a C2+ | C4 Lightspeed 
Live Server, update drivers, firmware, etc.

Downloading Mellanox and Nvidia Installers
Download these installers:

1. Download the Mellanox Windows host controller driver 
MLNX_WinOF2_All_AllOS_x64_release_2_940_22711_18.exe installer from https://
network.nvidia.com/products/adapter-software/ethernet/windows/winof-2/.

https://network.nvidia.com/products/adapter-software/ethernet/windows/winof-2/
https://network.nvidia.com/products/adapter-software/ethernet/windows/winof-2/
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2. Download the Mellanox firmware installer from https://network.nvidia.com/
support/firmware/connectx6dx/.

3. Download the MFT tools installer from https://network.nvidia.com/products/
adapter-software/firmware-tools/.

4. Download the mIxup tool installer from https://network.nvidia.com/support/
firmware/mlxup-mft/.

5. Download the Rivermax SDK (installer) from the Nvidia Developer Program. 
Programmer membership is required to download the Rivermax SDK.

Installing/Updating the Mellanox NIC and Rivermax Drivers
To update the Mellanox NIC driver, follow these steps:

1.  Run MLNX_WinOF2_All_AllOS_x64_release_2_940_22711_18.exe and follow the 
steps in the installer.

2. If you are configuring this server with a static IP address, set it now, before 
restarting the server.

Installing/Updating Rivermax for ST 2110
To update the Rivermax Library to support ST 2110 streaming, follow these steps:

1. Run the Rivermax_1.6.18_installer.msi and follow the instructions in the installer.

2. After installing the Rivermax library, copy the license file to C:\Program 
Files\Mellanox\Rivermax\lib\rivermax.lic.

Upgrading Mellanox Card Firmware
To update the firmware, use Mellanox Firmware Tools (installed with 
WinMFT_x64_4_15_1_9.exe).

The recommended firmware version is 22.33.1048.

Follow these steps using Mellanox Firmware Tools:

1. Open a command window with administrator privileges to find the MST device ID.

2. Execute mst status -v

The console returns Mellanox card data, similar to this:
mt4125_pciconf0 bus:dev.fn=02:00.0

mt4125_pciconf0.1 bus:dev.fn=02:00.1

In this example, mt4125_pciconf0 is Mellanox ConnectX-6 Dx Adapter #1 and 
mt4125_pciconf0.1 is Mellanox ConnectX-6 Dx Adapter #2.

3. Update the firmware for each device with the following command:
flint -d mt4125_pciconf0 -i ConnectX6Dx_FW_22_33_1048.bin burn

4. Repeat for the second device:
flint -d mt4125_pciconf0.1 -i ConnectX6Dx_FW_22_33_1048.bin 
burn

https://network.nvidia.com/support/firmware/connectx6dx/
https://network.nvidia.com/support/firmware/connectx6dx/
https://network.nvidia.com/support/firmware/mlxup-mft/
https://network.nvidia.com/support/firmware/mlxup-mft/
https://network.nvidia.com/products/adapter-software/firmware-tools/
https://network.nvidia.com/products/adapter-software/firmware-tools/
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5.  Verify network settings for the Mellanox NICs

6. Restart the server and proceed.

Configuring ST2110 Channels to use SDP Files
Paths to ST2110 compliant Session Description Protocol (.sdp) text files can be added to 
configure the Live Source ST2110 channel. At minimum, the path to the ST2110-20 
video SDP file should be specified.

To support external patching, NMOS can be enabled for the Live Source ST2110 
channel.

Basic requirements for the NMOS environment:

• An NMOS registry server, configured and deployed as required in a test environ-
ment

• NMOS ST2110 senders (for example, senders of ST2110-10/-20/-30 video, audio and 
data streams that are registered in the NMOS registry server)

• Telestream Live Source ST2110 channels that have the NMOS control enabled.

Install Bonjour for mDNS-based Discovery
Bonjour is required for environments where NMOS node devices do not support static 
IP address assignments, but has the limitation that all NMOS nodes and devices must 
be in the same subnet as the NMOS registry server. If Bonjour is needed, run the 
Bounjour64.msi installer on the NMOS registry server and the LightSpeed Live server 
and reboot the systems. Bonjour will then allow the devices to connect the registry 
server, to allow the NMOS registry to handle AMWA IS-04 Discovery. 

Configuring a Live Source Connection to NMOS Registry 
Server
For environments where Bonjour is not needed or can’t be used due to network policy, 
the Telestream Live Source Service can be configured to connect to the NMOS registry 
server, using Source Manager. For details, see the Live Capture User Guide.

The Telestream Live Source Service should restarted after making the changes.   After 
the Telestream Live Source NMOS device is registered, ST2110 channels enabled as 
NMOS receivers will also be registered.

Patching NMOS Senders to NMOS Receivers
After the Telestream Live Source Service is registered, NMOS enabled ST2110 channels 
can be patched to NMOS senders (ST2110 video, audio and data streams.) 

Bulk patching is not supported.

The Riedel NMOS Explorer can be used in a test environment for making patches. This 
application can be downloaded from https://myriedel.riedel.net/. 
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By default, the Riedel NMOS browser will try to connect to the Bonjour service. If 
Bonjour is not installed in the NMOS environment, the Riedel NMOS browser 
application will fail to start, but it also can be configured to connect directly to the 
NMOS registry host with a static IP, e.g. http://10.0.5.174:3212/x-nmos/query/
v1.3/ where:

10.0.5.174:3212 is the NMOS registry host IP address and the query port used by 
the NMOS registry host

Rivermax error messages:

If the system is not licensed, an error is displayed when an ST2110 source process is 
started: “Failed to Initialize Rivermax. Rivermax license file is missing, invalid, or incorrectly 
named (Rivermax error code 12)”.

If the driver/firmware is not properly installed, or the Mellanox NIC card is not properly 
inserted to the PCI-E slot: “Failed to Initialize Rivermax. There are no Mellanox devices that 
support Rivermax (Rivermax error code 8.)”
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Mellanox Card | Rivermax 
Installation Checklist

Use the topics in this chapter to update the NVIDIA Mellanox ConnectX-6 Dx EN 
adapter card in a Lightspeed Live server for use with Live Capture, including installation 
of the Rivermax Media Library for ST 2110 and configuring ST 2110 sources in Source 
Manager.

Topics
■Mellanox Card Specifications

■Mellanox Card Installation Software

■Updating the Mellanox Card

■Configuring ST 2110 Sources Using SDP

■Configuring ST 2110 Sources Using NMOS

Mellanox Card Specifications
The NVIDIA Mellanox ConnectX-6 Dx EN (900-9X6AG-0056-ST1/MCX623106AN-CDAT) 
is a 100GbE, dual-port QSFP56, PCIe 4.0 x16, tall bracket adapter card. It does not 
support on-board crypto.

Ethernet traffic is transmitted through the adapter’s SFP28/SFP56/QSFP56 connectors. 
The networking connectors allow for the use of modules, optical and passive cable 
interconnect solutions.

The networking ports have a Bi-color LED and one single color LED to indicate traffic/
error conditions.

Mellanox Card Installation Software
These installers and a license are required to perform the tasks in this checklist:

• Mellanox Windows host controller driver installer

• Mellanox firmware installer

• MFT tools installer 
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• Bonjour installer (optional)

• Rivermax Library license

Note: Before proceeding, locate these installers and copy the Mellanox_Installers 
folder over to the target C2+ | C4 | C5 Lightspeed Live server.

Updating the Mellanox Card
Use this topic to update drivers and firmware on a Mellanox ConnectX-6 Dx NIC in a 
Lightspeed Live server.

Quiesce the Lightspeed Live Capture Server
To update an operational C2+ | C4 Lightspeed Live server, follow these steps:

1. In Workflow Designer, wait for all current capture jobs to complete or stop them.

2. De-activate all active Capture and Tape workflows.

3. In Live Capture | Tape Capture web app, halt all capture operations.

4. In Live Schedule (if in use), halt events that are planned during this downtime.

Installing the Mellanox Driver and Verify NIC is Present
5. In the Installers > Mellanox folder, run the 

MLNX_WinOF2_All_AllOS_x64_release_2_940_22711_18.exe or later file to launch 
the installer; follow the directions.

6. When complete, right-click the Windows icon and select Network Connections.

7. See SXB1 Qr3A Port 1 and Port 2 icons to verify that Windows recognizes the 
Mellanox ports.

8. If the ports are missing, resolve by reseating the card and riser bracket and re-check 
before continuing.

Installing and Licensing Rivermax for ST 2110
Rivermax implements an API for media streaming applications. Rivermax runs on 
Mellanox ConnectX cards and makes use of ConnectX-dedicated hardware streaming 
accelerations. Rivermax enables compliance with SMPTE 2110-21, reducing CPU 
utilization and improving throughput.

To install Rivermax to support ST 2110 streaming, follow these steps:

1. In the Mellanox folder, run the Rivermax_1.6.18_installer.msi or later and follow the 
instructions in the installer.

2. After installation, copy the Rivermax license file which you received for this server 
to C:\Program Files\Mellanox\Rivermax\lib\. Rename it to rivermax.lic.

3. To complete installation, restart the server. Windows updates may delay your ability 
to log in and continue.
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Note: The Rivermax license for this Mellanox card will be delivered via email to the 
person performing installation. Each license is effective only for the specified serial 
numbered card. The rivermax.lic file in the installer directory may be used as a demo 
license if required.

Rivermax Error Messages

If the system is not licensed, an error displays when an ST 2110 source process is 
started: “Failed to Initialize Rivermax. Rivermax license file is missing, invalid, or 
incorrectly named (Rivermax error code 12).“

If the driver/firmware is not properly installed or the Mellanox NIC card is not properly 
inserted to the PCI-E slot, this error message displays: “Failed to initialize Rivermax. 
There are no Mellanox devices that support Rivermax (Rivermax error code 8).“

Upgrading Mellanox Card Firmware
To update the firmware, use the Mellanox Firmware Tools program, installed with 
WinMFT_x64_4_15_1_9.exe or later. The recommended firmware version is 22.33.1048.

1. Install Mellanox Firmware Tools (WinMFT64) if not already installed—run 
WinMFT_x64_4_15_1_9.exe or later to launch the installer; follow the instructions.

2. Open the Command Prompt window with administrator privileges and run 
'C:\Program Files\Mellanox\MLNX_WinOF2\mst status -v' to find the 
device ID.

The console returns Mellanox card data, similar to this:
mt4125_pciconf0 bus:dev.fn=02:00.0

mt4125_pciconf0.1 bus:dev.fn=02:00.1

In this example, mt4125_pciconf0 is Mellanox ConnectX-6 Dx Adapter #1 and 
mt4125_pciconf0.1 is Mellanox ConnectX-6 Dx Adapter #2.

3. For 25 GbE card (model MCX623102AN), update the firmware for each device with 
this command (where d mt4125 should be changed to your card ID):

flint -d mt4125_pciconf0 -i ConnectX6Dx_FW_22_33_1048.bin burn

4. Repeat for the second device:

flint -d mt4125_pciconf0.1 -i ConnectX6Dx_FW_22_33_1048.bin burn

5. For 100 GbE card (model MCX623106AN), update the firmware with this command:

flint -d mt4125_pciconf0 -i ConnectX6Dx_MCX623106AN-CDAT_F-
W_22_33_1048.bin burn

6. Repeat for the second device:

flint -d mt4125_pciconf0.1 -i ConnectX6Dx_MCX623106AN-CDAT_F-
W_22_33_1048.bin burn

Note: For these commands, either supply a path to the BIN file or put the files in the 
same folder as flint: C:\Program Files\Mellanox\WinMFT\.
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Note: If the command fails with “Command not found”, it's probably because the new 
environment variable hasn’t been updated. Restart the server and try again, or specify 
the full path:  
C:\Program Files\Mellanox\WinMFT\flint -d mt4125_pciconf0 -i 
ConnectX6Dx_MCX623106AN-CDAT_FW_22_33_1048.bin burn.

Configuring ST 2110 Sources Using SDP
If you aren’t using NMOS, paths to ST 2110-compliant SDP (Session Description 
Protocol) text files (*.sdp) should be added to each channel’s configuration in Live 
Source. At a minimum, you should specify the path to the ST 2110-20 video SDP file.

For each ST 2110 source, follow these steps in Source Manager:

1. Select ST 2110 to display its Configure Source dialog.

2. Disable the NMOS control to display its SDP file controls.

3. Supply fully-qualified paths to the video, audio, and ANC SDP files as appropriate.

4. Provide the video, audio, and ANC media index values, if required.

Configuring ST 2110 Sources Using NMOS
To support external patching, enable NMOS for the ST 2110 source.

These are the basic requirements for an NMOS environment:

• An NMOS registry server, configured and deployed as required within the test envi-
ronment

• NMOS ST 2110 senders of ST 2110-10/-20/-30 video, audio and data streams that 
are registered in the NMOS registry server

• Telestream Live Source ST 2110 channels that have the NMOS control enabled in 
Source Manager.

Installing Bonjour for mDNS-based Discovery
Bonjour is required for environments where NMOS node devices do not support static 
IP address assignments, but has the limitation that all NMOS nodes and devices must 
be in the same subnet as the NMOS registry server. Bonjour allows the devices to 
connect to the registry server, enabling the NMOS registry to handle AMWA IS-04 
Discovery. 

If Bonjour is required, install it—run the Bonjour64.msi installer on the NMOS registry 
server and the Lightspeed Live server and reboot both systems.
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Configuring Telestream Live Source Service for Connecting to 
the NMOS Registry Server
For environments where Bonjour isn’t needed or can’t be used due to network policy, 
configure the Live Source Service to connect to the NMOS registry server. 

The NMOS settings only display on Lightspeed Live servers with a Mellanox card 
installed. After the Telestream Live Source NMOS device is registered, ST 2110 channels 
enabled as NMOS receivers are also registered.

Follow these steps:

1. Delete the etcd database or upgrade the Source version to display the NMOS 
settings. (The upgrade code re-adds the settings if they’re missing for 2110 
systems).

2. Launch Live Source Manager and select Settings > Manual NMOS Registration.

3. In the Manual NMOS Registration panel, enable Manual NMOS Registration. When 
enabled, update the registry address, registry port, API version, node port, and 
connection port

4. Click away when complete, to save these values and update the JSON config file.

5. Restart the Telestream Live Source Service for changes to take effect.

Note: Disable Manual NMOS Registration and save the System Settings to remove the 
registry_address, registration_port, and registry_version settings from the config file 
and restart the Telestream Live Source Service for changes to take effect.

Patching NMOS Senders to NMOS Receivers
After registering the Telestream Live Source Service, NMOS-enabled ST 2110 channels 
can be patched to NMOS senders (ST 2110 video, audio and data streams.) Bulk 
patching is not supported.

Note: In Source Manager, settings only display for ST 2110-based servers. If a Live 
Source 3.6.1 system is converted from SDI to ST 2110, the etcd db must be deleted or 
Live Source Manager must be upgraded in order for the NMOS settings to display.

You can use the Riedel NMOS Explorer in a test environment for making patches. 
Download this application from https://myriedel.riedel.net/. 

The Riedel NMOS browser attempts to connect to the Bonjour service. If Bonjour is not 
installed, the Riedel NMOS browser application fails to start. Configure it to connect 
directly to the NMOS registry host with a static IP—for example: http://10.0.5.174:3212/
x-nmos/query/v1.3/ where:

• 10.0.5.174 is the NMOS registry host IP address

• 3212 is the query port used by the NMOS registry host.
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Managing your Web Apps

Effective use of your Live Capture web apps requires a supported web browser, 
learning how to launch each web app and connect to a Live Capture server, and how to 
use the apps effectively in a networked environment and deal with changes in your 
network such as changing a Vantage domain name.

Topics
■ Web Application Browser Requirements

■ Efficient Use of Capture Web Apps

■ Launching Lightspeed Live Web Applications

■ Launching the Source Manager Web App

■ Changing the Vantage Domain Name
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Web Application Browser Requirements
Vantage and Live Capture web applications are implemented for execution in Microsoft 
IIS. Java Script and cookies must be enabled to use Capture web applications properly.

Capture web apps are implemented for viewing in the Chrome browser, version 
113.0.5672.93 or greater. Other browsers are not supported. Chrome is installed by 
default on Live Capture servers and configured to operate properly. Windows is 
configured to permit Chrome to update automatically.

You can use Chrome on any workstation or other computer, regardless of the operating 
system, that supports Chrome.

For optimal viewing of web apps, set your monitor size to 1920 x 1080 or greater.
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Efficient Use of Capture Web Apps
When a user is logged into the Capture web applications, the web app consumes 
network and server resource cycles, particularly while viewing multiple channels. When 
viewed, each channel connects a thumbnail and preview stream to that instance of the 
web application. Multiple users connected to the web application can degrade its 
performance. Therefore, care must be taken to ensure that the Live web apps do not 
consume resources unnecessarily when not being used. 

WARNING: Windows IIS allows for a limited set of web socket connections to 
applications. Over an extended period, if Capture web apps are opened in 
multiple browsers, the web server and browser may exceed the connection limit. 
This results in thumbnails and previews not displaying in the web apps. To avoid 
this situation, close any browser connected to the Live Capture Portal that are 
not being used.
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Launching Lightspeed Live Web Applications
Note: This topic applies to all Live web apps except the Source Manager web app. For 
details on launching Source Manager, see Managing Video Sources. 

Most Lightspeed Live web apps are launched from Vantage’s web portal, which 
requires logging in to Vantage. Logging in to a Vantage domain from a web application 
is a bit different than logging in from a Vantage Windows client application, such as 
Workflow Designer. 

To start Live Capture | Tape Capture | Live Schedule Pro web applications (or other 
Vantage client web apps), do the following:

1. Display the Vantage web portal—open Chrome and enter one of these URLs:

http://<IISServerName>/Vantage where <IISServerName> is the DNS name of 
the IIS server—by default, the same as the Vantage domain server

OR

If you’re running Chrome directly on the server which hosts Vantage, enter  
http://localhost/Vantage.

Vantage displays its web portal (also referred to as the Vantage home page). 
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Note: If you don’t know your Vantage domain’s server name (by default, the server 
where the Vantage domain database is hosted), contact your Vantage administrator / 
IT department.

2. Click on the panel for the web app you want to launch.

3. If you’re prompted to log in to Vantage, enter your credentials.

Note: If you’ re not authorized to log in, contact your Vantage domain administrator.

The apps that display in the Vantage web portal vary depending on your licenses. Click 
the web app you want to use. 

The first time you open the Live Schedule Pro web app, you must use the Vantage web 
portal (http://localhost | <host name>/Vantage/). This creates a cookie for a persistent 
connection to the Vantage Live Service. Opening the Schedule web app for the first 
time directly via the URL bypasses this process, resulting in the error No client 
connection to Live server.

Note: If you are logging into a web app from another workstation on the network, 
you may encounter a connection error: No client connection to Live server. Clear your 
browser cache and retry, determine if the Vantage Live Service is running and 
accessible, or go to http://<host name>/Vantage to display the Vantage web portal, 
and launch your web app there. Also, verify that the web app’s port isn’t blocked by a 
firewall (Firewalls and Blocked Ports Limit Functionality).
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Launching the Source Manager Web App
The Source Manager web app (see Managing Video Sources) is installed on every 
Lightspeed Live Capture server.

To start the Source Manager web app and log in, enter http://localhost:8090/ | http://
<Remote host name>:8090/ in your Chrome browser. 

Note: Unlike Capture, Tape, and other web apps, Source Manager does not utilize the 
Vantage web portal (Launching Lightspeed Live Web Applications) for launching or for 
managing user credentials. You can modify Source Manager user credentials using the 
Group Portal (see User Administration).

When you are accessing Source Manager locally (Chrome is running on the same Live 
Capture server as Telestream Live Source Service), use the keyword localhost. If you are 
accessing Source Manager remotely (Chrome is running on a computer that is not a 
Live Capture server), use the Live Capture server’s host name.

Source Manager displays the login panel:

Enter your user name and password. The default user name and password is admin/
live!. Users are defined using the Groups Portal web app (User Administration).

Logging Out of Source Manager
To log out of Source Manager, click the User icon in the toolbar at the top right corner of 
the window at the far right edge of the Source Manager title bar. Source Manager logs 
you out and immediately displays the Log In panel.

To log back in, enter your user name and password. The default user name is admin and 
the default password is live!, and it can not be altered. You can create additional users in 
the Group portal (see User Administration).
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Changing the Vantage Domain Name
If you have changed your Vantage server's host name (by default, it is used to name 
your Vantage domain), you should verify that the Lightspeed Live Capture web 
application is using the new domain name. The currently-connected domain name 
displays in the upper right corner of the web app:

If it is not connected to the correct domain, change the domain with these steps:

1. Click on Change Domain. 

2. Click OK to log out.

3. Click Search in the dialog that displays.

4. Select the correct domain, and click OK.

5. Enter the user name and password to log into the target domain. 
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Lightspeed Live Server 
Resource Requirements

Live Capture uses a variety of codecs and container formats to digitize live video and 
serialize it into media files. At the simplest level, Live Capture consists of customizable 
workflow actions that automate the real-time video capture process. 

A workflow is the process you create in Vantage that ingests an incoming live source 
and compresses it using one of many codecs and saves the file using one of many 
container formats. It utilizes the Vantage Capture action to perform these tasks.

Given the data and computation intensity of multiple, simultaneous processes, care 
must be taken not to exceed the limits of the Lightspeed Live server’s available 
resources.

General information is provided, as well as model-specific resource usage guidelines.

Note: This chapter provides information to help you calculate Lightspeed Live 
Capture resource usage when hosted on a Lightspeed Live server—it is not intended 
for use on VM | cloud-based Live Capture systems. 
On VM and cloud-based systems, you should conduct your own performance testing 
to determine how to configure your system and use it to meet these guidelines.

Topics
■ Overview

■ Balancing CPU Processor Group Affinities

■ Processes & Factors Affecting Performance

■ Capturing Uncompressed Media Via SDI

■ Maximum Concurrent Captures

■ Maximum Concurrent Captures for VM-based Live Capture

Note: CPU utilization should not exceed 75%; 60 percent or less is recommended. 
Contact Telestream (Obtaining Support | Information | Assistance) if you encounter 
situations where the load is not balanced across both nodes/sockets or exceeds 75%. 
Also see Use Source Manager to Manage Affinity Settings for affinity balancing.
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Overview
You should not configure multiple workflows to ingest the same SDI source under 
normal operation conditions, because they may be executed simultaneously and 
potentially overloading the system. Instead, source routing should be used to achieve 
the same result. This source-to-workflow flexibility makes it important to ensure that 
simultaneous processes being performed on a Lightspeed Live server do not exceed its 
total processing capabilities.

Every process should be taken into account when determining what resources are 
required. Processes that materially affect system resources include the primary output 
codec, secondary output codec and the input video’s frame size, video bit depth plus 
the number of input sources—both SDI and IP-based. Also, the Live web app’s preview 
and thumbnails, and the time shift buffer (if enabled) affect resources. 

Keep in mind that the CPU is assigned to a processor group based on which source 
input is selected. See Balancing CPU Processor Group Affinities for details.

Balancing CPU Processor Group Affinities
Live Capture uses the Windows Processor Affinity feature to balance CPU loads, to gain 
the most efficient CPU usage for capturing live video. 

Note: Processor Affinity is enabled for load balancing. On first-generation, C2, or C2+ 
Lightspeed Live servers (or any system with 64 logical processors or less, such as a VM 
or Software Only server that performs one recording at a time.), where you can disable 
processor affinity for SDI sources, the Processor Affinity control allows you to disable 
Preferred Processor completely, in which case the live source process will try to use 
both sockets. Generally, you should use Live Capture with this setting enabled. 
For IP sources, balance the CPU load manually using the Preferred Processor control.  
You should disable Processor Affinity only when capturing UHD/4K video, in which 
case the live source process will attempt to use both sockets.

Live Capture workflows execute capture processes on the processor group (also known 
as CPU affinity) to which the associated source has been assigned.

Live Capture automatically assigns each source affinity to a processor group (Affinity 1 
or Affinity 2) at start-up. Although Live Capture alternates CPUs when creating IP 
sources, you should verify affinity to ensure your sources are equally distributed 
between sockets.
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Use Source Manager to Manage Affinity Settings
You use Source Manager to view and modify all of your source’s affinity status and 
assignment, which is controlled by the Preferred Processor control in the source’s 
Configure Source dialog, as shown here:

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K. 
This control displays on all server models when Advanced Settings is enabled. The 
ability to disable Preferred Processor is enabled only on systems with less than 64 
logical processors.

To display the Preferred 
Processor control, enable 
Advanced Mode in the System 
Settings panel.

Preferred Processor can’t be 
disabled when the server has 
64+ processors.

Preferred Processor can be 
disabled when the server has 
64 or less processors.
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Care should be taken to ensure that a processor group is not assigned more workflows 
than it can support. See the Resource Utilization tables later in this chapter for specific 
processor and codec capacities.

To determine which processor group a given source has been assigned, in Source 
Manager, make sure Advanced Mode is enabled (Managing System Settings). Select a 
source to view the processor group assignment (in the Affinity column)—as well as CPU 
utilization—in real time:

Managing Affinity on C1 | C2 | C2+ Servers
C1 | C2 | C2+ Lightspeed Live servers have two separate CPU processor groups. When 
enabled, processing associated with each Capture | Tape job is assigned to the assigned 
CPU on the server’s multi-core CPU to prevent inefficient process mapping across CPU 
sockets during heavy loads, typically when several sources are capturing concurrently. 

You can manually set affinity to a specific socket for any source type on any model. If 
you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use this control to balance them. If IP sources are maintained long term, it 
may be helpful to assign each source a preferred processor.

For both source types—dynamically created sources (IP sources) and permanent 
sources (SDI sources)—it is possible to delete dynamically created sources in a way that 
leave the remaining sources unbalanced. 

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0.

On a C2+ Lightspeed Live server, with advanced mode enabled (Managing System 
Settings), you can disable manual affinity completely—disable the Preferred Processor 
control in the Configure Source dialog. When you disable Preferred Processor, the Live 
Source process will attempt to use both sockets.

Managing Affinity on C4 | C5 Servers
On a C4 or C5 server, you can manually set affinities when required for IP 
sources.Processor affinities should be balanced for optimal utilization. Generally, SDI 1 | 
3 | 5 | 7 are assigned an affinity value of 1. SDI 2 | 4 | 6 | 8 are assigned affinity 2.

Balancing affinities is generally automated. SDI affinities—set automatically. When you 
dynamically create sources, you typically don’t need to adjust affinities in order and use 
them. However, if you delete alternate IP sources, for example, you may be left with 
sources that do not balance. 

Affinity for a given source is set zero (0) when Preferred Processor is disabled for the 
source.
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When performing 4 concurrent captures, they should be balanced across processor 
arrays. For example 1, 2, 3, 4 or 5, 6, 7, 8 are balanced across affinity groups. 1, 3, 5, 7 or 2, 
4, 6, 8 aren’t balanced, because they are assigned the same affinity group and thus, will 
saturate the resources of the CPU processor group.

On a C5 server, when you are capturing 6 10-bit sources, you should use all four SDI 
ports of the first SDI card and two of the second. The last two ports of the second card 
remain unused. These two unused sources should be alternating affinities to maintain 
balance in the rest of the sources.

Note: CPU utilization should not exceed 75%; 60% or less is recommended.

For more details, see Source Information and Statistics Panel and Maximum Concurrent 
Captures.
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Processes & Factors Affecting Performance
These processes and factors materially affect system resources:

Primary Output Codec
The Primary Output codec may utilize the CPU or GPU for encoding. It is the most 
resource intensive component. See the codec charts below for general information on 
CPU utilization.

Secondary Output codec
The specified Secondary Output codec, like the Primary Output codec, may utilize the 
CPU or GPU for encoding, and uses the CPU for video processing library operations 
such as spatial formatting and interlacing. It is the second most resource intensive 
component. 

Codec/Source Input Bit Depth
It is considered best practices to match the selected codec's bit depth to the bit depth 
of the source input. For example, DNxHD HQX is a 10-bit codec. Set the associated 
source input to 10-bit in order to avoid additional processes to convert the incoming 
frames to match the codec's bit depth.

In contrast, DNxHD SQ is an 8-bit codec, so you should use it only on 8-bit source, in 
order to obtain the most efficient resource usage.

ST 2110 Source Bandwidth Limits
Live Source manager does not impose a limit on the number of ST2110 sources, but 
there are practical limits you should consider. The primary limit on the number of ST 
2110 is imposed by the CPU and disk write speed of the Live Capture server. It is also 
possible to overload network bandwidth with connections to live source receivers.

Consider as a starting point, that the data throughput for a 1080p 59.94 10-bit video 
source is about 3 Gbps. A 25Gbe NIC can support approximately 8 of these 
connections: 25 Gbps / 3 Gbps  =  8 sources. Exceeding this limit will result in an 
unstable connection inducing packet loss.

For a 100Gbe connection, the theoretical maximum concurrent live sources is 100 / 3 = 
33 from the perspective of network sustainability. 

Live Capture Web App
Using the Live Capture web app directly on a Lightspeed Live server adds to the 
resource load. This fact must be taken into account when capturing multiple channels 
concurrently. For details, see Live Capture Web App.
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Telestream recommends that you connect to the Live web applications from browsers 
running on client workstations and you do not run them directly on a Lightspeed Live 
server. This avoids additional decoding load for the Live web app's preview directly on 
the server.

Determining the Time-Shift Buffer Duration
The Time-Shift buffer in Live Capture has a maximum duration of 10 seconds for each 
source. The memory used by each instance of the Time-Shift buffer is directly related to 
the frame size and frame rate of the source video. 

Note: For more details about the Time-Shift buffer, see Creating Live Capture 
Workflows, in the Live Capture User Guide.

Use this data as a baseline when determining the duration of each source’s time-shift 
buffer:

Standard Definition (SD) Codecs
• NTSC and PAL—The total for all (maximum 8 SD sources) source Time-Shift buffers 

combined should not exceed 80 seconds.

High Definition (HD) Codecs
• 720p/1080i /1080p up to 30fps— The total for all Time-Shift buffers combined 

should not exceed 80 seconds.

• 720p/1080p above 30fps—The total for all Time-Shift buffers combined should 
not exceed 60 seconds.

UHD/4K Codecs
• The total for all (maximum 2 UHD/4K sources) Time-Shift buffers combined should 

not exceed 20 seconds.
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Capturing Uncompressed Media Via SDI
Live Capture hosted on a Lightspeed Live server can capture Uncompressed SD | HD 
|UHD/4K in 8- or 10-bit via SDI. Several factors (both platform- and media-based) 
determine capture limits. 

• Storage Location—Local media drive or shared storage (NAS | SAN).

• Drive Configuration—The drive configuration is governed by the number of drives 
in your Live Capture server’s media drive and the RAID type. A standard Live Cap-
ture server ships with a media drive containing 4 drives striped as RAID 5. In addi-
tion, the media drive can be expanded to 8 drives by purchasing Media Drive 
Option LS-LIVE-4TB-OPTION. The RAID type of the media drive can be changed   
from RAID 5 by the end user to RAID 0 if disk I/O is more important than data redun-
dancy. See Rebuilding the Lightspeed Live Storage RAID.

• Frame Size | Frame Rate | Scan Type—The incoming source frame size, frame rate, 
and scan type (interlaced (i) | progressive (p)) affects the requirements for capturing 
and generating an uncompressed output file.
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Maximum Concurrent Captures
Use this table to determine the resource requirements for capture workflows executing 
concurrently on a Lightspeed Live server, based on the codec and profile you’ve 
specified in the Capture action. When ingesting multiple concurrent feeds, the CPU 
load is automatically balanced across both NUMA nodes/CPU sockets.

Caution: You shouldn’t route more than six 10-bit, 59.94 SDI sources to a server, 
whether you’re capturing them or not—over time, it degrades performance. If all 
8 sources are 1080p 59.94 progressive, two of them should be switched to Force 
8-bit or they should be a lower frame rate than 59.94 FPS. 

Codec and Profile Max. Concurrent Captures per Server
C2 C2+ C3 C4/C5

UHD/4K
JPEG2000 YUV 10-bit lossless 1 up to 30p 1 up to 30p 2 up to 30p
JPEG2000 YUV 10-bit lossy 1 up to 30p 1 up to 30p
Sony XAVC Long QFHD Class 100  1 up to 30p  2 up to 30p
Sony XAVC Long QFHD Class 200  2 up to 30p
Sony XAVC Class 300 (4K/UHD) 1 up to 30p 

(CBG | VBR

1 up to 60p 
(CBG only)

 2 up to 30p  2 up to 60p

Sony XAVC Class 480 (4K/UHD) 1 up to 30p 
(CBG | VBR)

2 up to 30p 2 up to 60p
(CBG only)

Avid DNxHR 4K/UHD up to HQX 1 up to 30p 2 up to 30p 2 up to 60p
Apple ProRes 422 4K/UHD SQ 1 up to 60p 2 up to 60p 2 up to 60p
Apple ProRes 422 4K/UHD HQ 1 up to 60p 2 up to 30p 2 up to 60p
x264 4K/UHD 1 up to 30p 2 up to 30p 2 up to 30p
x265 4K/UHD 1 up to 30p 2 up to 30p 2 up to 30p
XAVC QFHD Long Class 100  1 up to 30p 2 up to 30p
XAVC QFHD Long Class 140
XAVC QFHD Long Class 200 1 up to 30p 2 up to 30p
HD 1080p @ 59.94
AVC-H.264 2 4  4 6
Panasonic AVC-Ultra 25 2 4  4 6
Panasonic AVC-Intra 50 2 4  4 6
Panasonic AVC-Intra 100 2 4  4 6
Panasonic AVC-Intra 200 2 4  4 6
Sony XAVC Class 100 (HD) 2 4  4 6
Sony XAVC Long Class 50 2 4  4 6
HEVC 2 4  4 6



Lightspeed Live Server Resource Requirements
Maximum Concurrent Captures for VM-based Live Capture

148 

Live Capture Administration Guide

Maximum Concurrent Captures for VM-based Live 
Capture

A Live Capture Software system requires one license per concurrent capture, for a 
maximum of four licenses per VM. If a single license is active but multiple Capture 
workflows are active, you can not start a capture operation. See Software-Only 
Licensing for licensing details.

Avid DNxHD up to HQX 2 4  4 6
Apple ProRes HD 444 2 4  4 6
Apple ProRes 422 HD up to HQ 2 4  4 6
Sony XAVC Class 100 2 4 4 6
x264 HD - Baseline, Main, High (8-bit) 2  4 6
x264 HD - High 10, High 422(10-bit) 4  4 6
x265 HD - Main10 2 4  4 6
JPEG2000 YUV 10-bit lossless 2  1 2
JPEG2000 YUV 10-bit lossy 2 1 2
HD 1080i @ 29.97
Sony XDCAM 420/422 (8-bit) 4 8 8
DVCProHD 4 8 8
HD 1080i @ 59.94
Sony XDCAM 420/422 (8-bit) 2 8 8
DVCProHD 2 8 8
JPEG2000 YUV 10-bit 2 2 4
HD 1080p @ 29.97
Avid DNxHD 444 2 6 6
Panasonic AVC-Ultra 50 4 6
Panasonic AVC-Intra 50 2 8 8
Panasonic AVC-Intra 100 2 8 8
Panasonic AVC-Intra 200 2 8 6
SD NTSC
IMX 2 4 8 8
DV/DVC Pro 2 4 8 8

Codec and Profile Max. Concurrent Captures per Server
C2 C2+ C3 C4/C5
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Connecting VTR Systems

This chapter describes connecting VTR units to a Lightspeed Live Server using the 
optional 4-port USB-to-RS-422 VTR Interface Kit (purchased separately) so that you can 
control them with the Tape web app.

The 4-port RS-422 VTR Interface Kit enables you to connect up to 4 VTRs to the 
Lightspeed Live Server. The VTR Interface Kit muxes and passes multiple RS-422 port 
connections through a single USB cable, connected to the Lightspeed Live Server.

To support 8 VTRs you can use two 4-port VTR Interface Kit.

Note: Before you can capture video from a VTR, the system must be set up and 
configured (Configuring Vantage and Updating Live Capture), including a tape capture 
workflow (Creating Vantage Capture Workflows for Live and Tape Media).  
Use of the Tape Capture web app is described in Capturing Tape Media.

Topics
■ 4-Port Interface Kit Components

■ Installing the RS-422 Interface Box

■ Connecting a VTR to the Lightspeed Live Server

■ RS-422 Connector Pin Assignments

■ Configuring RS-422 Port Latency Time
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4-Port Interface Kit Components
The 4-Port RS-422 VTR Interface Kit includes these components: 

• One USB-to-RS-422 interface box, pre-mounted, providing four RS-422 serial ports

• One 1R-U rack-mount tray that can hold two RS-422 interface boxes

• One USB cable to connect the RS-422 interface box to the Lightspeed Live Server

• Two sets of RS-422 DB9-to-RJ45 (Ethernet style) adapters:

– Four Female DB9-to-RJ45 blue adapters to connect to the RS-422 interface box. 

– Four Male DB9-to-RJ45 gray adapters to connect to a VTR.

Note: The blue, female adapters are for server side use; the male gray adapters are for 
the VTR.

• Rack mount tray mounting hardware (see image below) includes:

– Four 10-32 rack screws and washers

– Four G-type cage nuts

– One small tie-wrap to secure the USB cable to the tray.

The RS-422 interface box is powered by the Lightspeed Live Server’s USB port, so no 
additional power supply is required. Drivers for the USB-to-RS-422 interface box are 
included in the software package and are installed as one of the steps below.
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Installing the RS-422 Interface Box
The RS-422 interface box and tray should be installed in a rack. It is best installed in the 
rear of the equipment rack directly behind the Lightspeed Live Server—or directly 
above or below—to be close to the Lightspeed Live Server USB ports.

To install the USB-to-RS-422 interface box in its rack mount tray, follow these steps:

1. Insert the USB cable into the 
rear of the RS-422 interface 
box.  
Fasten the USB cable to the tray 
by inserting the tie wrap 
through the raised anchor tab 
and tighten it to secure the 
cable. 
 

2. To prepare the tray mounting 
location, place the four G-type cage nuts 
onto holes of an open rack space that is 
close to the Lightspeed Live Server.  
 
 

3. Install the tray with the supplied screws 
and washers into the cage nuts.

4. Making sure that the Lightspeed Live Server is off, attach the USB cable to the 
Lightspeed Server; for a single 4-port box, insert the USB cable into either USB port. 
For two 4-port boxes, plug box 1 into the lower USB port to support VTRs 1-4; plug 
box 2 into the top USB port for VTRs 5-8.

Do not turn on your Lightspeed Live Server yet. Proceed to Connecting a VTR to the 
Lightspeed Live Server, following.
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Connecting a VTR to the Lightspeed Live Server
If you have a single VTR, you should connect it (RS-422 and SDI) through the box to the 
Lightspeed Live Server on the first port. For example, connect the VTR’s RS-422 port to 
Channel 1 (CH1) on the RS-422 interface box and then connect the VTR’s SDI Out to SDI 
1 on the Lightspeed Live Server. 

For multiple VTRs, you must plug VTR1 into RS-422 and SDI Port 1, VTR2 into RS-422 
and SDI Port 2, etc.

Note: The backplane of the Lightspeed Live Server has two USB ports. When using 
two 4-port RS-422 boxes to support up to 8 VTRs, connect the bottom USB port to the 
4-port RS-422 box supporting VTRs 1 through 4 and the top USB port connects to a 
second 4-port RS-422 box supporting VTRs 5 though 8. 

To make the connections for each VTR, follow these steps:

1. Turn off the VTR and the Lightspeed Live Server.

2. Position or install the VTR(s) in a safe and convenient location co-located near the 
RS-422 box and the Lightspeed Live Server.

3. If you are using RJ45 cables for control, attach the gray, male DB9-to-RJ45 adapter 
to the RS-422 terminal on the VTR.

Note: If an RS-422 router is between the RS-422 interface box and the VTR, the male 
DB9-to-RJ45 gray adapter should be plugged into the router on the Lightspeed Live 
Server side of the system. 

4. To prepare for VTR connection, If you are using RJ45 cables for control, attach a 
female DB9-to-RJ45 blue adapter to the Channel 1 (CH1) RS-422 serial port on the 
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interface box. Attach additional DB9-to-RJ45 blue adapters to other channels if you 
plan to connect more than one VTR. 

Connect a user-supplied serial cable into the RS-422 port or Cat5E (or higher) cable 
into the RJ45 jack on the adapter connected to the VTR. A Cat5E (Cat5 Enhanced) 
cable is recommended; a straight-through pin-to-pin type (not a cross-over cable) 
is required. The maximum cable length is 100 meters (328 feet).

5. Connect the other end of the Cat5E cable into the DB-9 connector or RJ45 jack on 
the adapter connected to the RS-422 interface box, on the terminal number that 
corresponds to the SDI source (input) number you want to use on the Lightspeed 
Live Server. 

6. Connect an SDI cable to the SDI Output terminal on the VTR.

7. Connect the other end of the SDI cable to the SDI input terminal on the Lightspeed 
Live Server that corresponds to the same terminal number you connected to on the 
RS-422 interface box.

8. Power up the VTR and switch it into the proper Remote mode for RS-422 control.

9. To establish serial communication, the RS-422 Interface Box must be initialized in 
the Vantage Live Service on the Capture server. 

10. To initialize the device, make sure that it is plugged into a USB port and re-start 
your Live Capture server.

When all connections are complete between the VTR, the RS-422 interface box, and the 
Lightspeed Live Server, the VTR connection is initialized and CH1 (Channel 1) of the RS-
422 interface box automatically synchronizes with SDI 1 on the Lightspeed Live Server, 
and similarly for all other VTRs.
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RS-422 Connector Pin Assignments
Use this pin assignment diagram if you have to create custom RS-422 cables for your 
USB-RS-422 interface box.
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Configuring RS-422 Port Latency Time
The RS-422 port’s latency is set at 1 msec by default. However, if new drivers are 
installed or a new USB-to-RS-422 interface box is used, the latency value may not 
persist and should be reconfigured to 1 msec or other value as required.

Note: The COM port number typically starts with 3 for VTR connections because COM 
ports 1 and 2 are permanent and reserved. Therefore, VTR1 is typically COM port 3; 
VTR2 is 4, VTR5 is 7, etc.

Follow these steps to set each USB Serial Port’s Latency Timer value to 1 msec:

1. Open Device Manager on the Lightspeed Live Server.

2. Click on Ports > USB Serial Port.

3. Select the first USB Serial Port, right-click and select Properties.

4. Select the Port Settings tab and click Advanced:

5. Change Latency Timer to 1 msec and click OK.

6. For multiple VTRs, repeat steps 3, 4 and 5 for the remaining USB serial ports. 

7. Click OK to update and close the Device Manager.
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